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No. ICT Tools Faculties using ICT Tools
1 | VM-Edulife Software: All
- | Demonstration software on animal experimentation | pms. S.S.Shaikh
’ (Ex-Pharma): Ms. S.V. Kathale
3 | LCD Projector: All
_ Dr. K.S. Jain
4 | Chem Draw Software: Mr. P.V. Rane
Mr. A.N. Phuge
Dr. K.S. Jain
5 | Chem sketch Software: Mr. P.V. Rane
Mr. A.N. Phuge
6 | Computer and Mobile Apps All
/| Educational Websites All
Windows Office (Word, Excel, Power point, o
8
Outlook)
Dr. J.S. Dhumal
9 | Blogs Mr. S.N. Ghodekar
Mr. A.N. Phuge
Dr. I.S. Dhumal
10 | Motic Microscope Software:
i Mr. S.N. Ghodekar
Ms. P.S. Deorankar
11 | Word th software:
Akt i Mr. S.N. Ghodekar
Dr. K.S. Jain
12 | You Tube Dr. J.S. Dhumal
Ms. A.K. Thikekar
Mr. A.N. Phuge
13 | Artificial intelligence (Al) All
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Chapter ... 8

Drawing Structures and Reactiong
using Different Softwares

o LEARNING OBJECTIVES ¢

After completing this chapter, student should be able to understand: |

°  Various softwares used for the drawing of chemical structures and reaci.&wns.
o  Use of software ChemSKetch for drawing chemical structures and react.wns,
o  Use of software ChemDraw for drawing chemical structures and reactions.
Procedure for starting ACD/ChemSKetch.

°  Drawing Reaction Mechanisms in ChemSKetch.

°  Use of computer programmes in pharmacy.

EXPERIMENT 8.1 ]
e Aim: To draw chemical structures and reaction schemes by using ChemSketch®

Software.

o Category: Freeware
e Link for download: https://www.acdlabs.com/resources/free-chemistry-software-

apps/chemsketch-freeware/ #chemsketch_modal
°* Theory:
The term chemical structure represents a range of items from very simple molecules
(e.g., diatomic hydrogen), to very complex ones (e.g., such as protein). Therefore, a
computer program has been the best tool since a long time for the chemists for creating
and. modifying representations of chemical structures and reactions; storing them and
retrieving as well as exporting them at a click of the computer. Currently, several
computer programs including:
(i) Standalone programs:
e.g- ACD/ChemSketch, ArgusLab, Bkchem, ChemDraw, ISISDraw, etc.
(i) Java Applets: ’ l
e.g. AccelrysJDraw, JChemPaint, JME Molecule Editor
(iii) JavaScript embeddable editors:
& ggiiﬁnguc:?trol::rawChem, Ketcher, Marvin Js, Molispiration WebME molecule editor
e.g. MolEdit, marvin, PubChem online

(8.1)
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(v) Mobile editor apps:
e.g. ChemDoodle Mobile
ChemSketch® by ACD LABS is a comprehensive structure editor with a variety of to
and functionality that ease the communication of scientific and chemical information.

Salient features/capabilities include:
o Draw molecular structures, generate structures or copy/paste f

ols

rom ChemDraw.

Easily and quickly known molecules or templates can be included.

Insert pre-drawn templates of amino acids, aromatics, steroids, sugars, and more.

Search the Dictionary of >170, 000 systematic, trivial and trade names.

Easy to draw reactions and complex chemical schemes (including biotransformation
maps, use graphical templates and tools to communicate chemistry and chemical
biology concepts e.g., chemical bond types, Lewis structures, molecular orbitals,
Newman projections, peptide sequences, and more).

Import and export structure files in a variety of standard file formats.

o Draw complex schemes, such as biotransformation maps, with ease.

Draw organic molecules, organometallics, biomolecules, polymers, Lewis structures,
2D and 3D structure representations and more. Calculate quantities for chemical
reactions (with automatically calculated chemical formula, molecular weight etc.).

Why has a Drawing Package?
A Drawing package is useful to have so molecular, shortened structural and full

structural formulae can be inserted into Activity sheets, Tests and Prelims, and Powerpoint

presentations. It is also possible to generate informa
compound and its molecular weight using these application pro
free on the Internet.
Theory of Working:

ACD/ChemSketch is a molecular modeling program used to create and modify images
of chemical structures. Also, there is a facility in this software that allows molecules and
molecular models displayed in two and three dimensions, to understand the structure of
chemical bonds and the nature of the functional groups. The program offers some advanced
features that allow the molecules rotate and apply colours to improve visualization. It has
several templates with ions and functional groups with the possibility to add text and use
other tools to optimize the productions created by the software.

Specific Functions:
o You can now write your ChemSketch files in PDF format, suitable for use with Adobe

Acrobat Reader and related software.
o It can also export structures in Chemical Markup Language (CML) format. Convert

SMILES notations to structures, and re-convert structures back to SMILES.

(Designations and stereochemistry excluded.)
o The atomic mass can be calculated, not exactly t

common isotopes.

O O O O

tion such as the systematic name of a
grams. Many are available
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Procedure for starting ACD/Che
Once ACD/ChemSketch has been install
start it:
1. Start Microsoft Windows.
2. Double-click the ChemSketch icon.

mSketch:
ed on your computer, follow these basjc Steps
0

OR
From the Start/Run menu in the Windows 95/98/2000 or NT taskbar, choose

ACD/Labs and then choose the ChemSketch icon.
OR
Double-click the program file "chemsk.exe” in the folder where you have installed g
ACD software. By default this is ACD50.
OR
If you have other ACD/Labs programs running, from the ACD/Labs menu choose

ChemSketch.

3. You should see an opening splash screen. If this is the freeware version, you will see
the ACD/Labs Products screen. Click OK to close it. If you wish to suppress this
dialog box for the subsequent start-ups, choose Help > ACD/Labs Products and

clear the Show this Screen at Start-up check box.
(A) Starting the Program for the First Time:
The File Association dialog box may appear.

{".ra
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1. This contains a selectable list of file extensions and file types - CS ChemDraw
(*CHM), REACCS Rxnfiles (*.RXN), ISIS/Sketch (*.SKC) and possibly others which you
may want to open automatically with ACD software from now on. If so, click the
check boxes of the file formats you want to add, and then click the Yes button,

2. If you do not want to have ChemSketch automatically open files with the listed
extension, or are not sure, leave the check boxes blank and click the No button.

3. Then you will see a Tip of the Day box, which you can close after reading.

(B) Changing File Associations:

If you have not selected all formats, the default file association can be viewed or
changed at any time by going to the File menu and selecting File Association. If you have
selected all formats, then you receive a message, “all supported file types are already

associated with the current application.” In this case, to change the file associations, you can
do it through Windows Explorer.

1. Open Windows Explorer, and select a file with the extension for which you want to
create the association.

2. Hold down the SHIFT key and right-click on the file. From the pop-up menu, select
Open With.

3. Set the application that should be used to open the file and select the Always use
this program check box.

4. Click OK and close Windows Explorer.
(C) Structure and Draw Mode icons:

When ACD/ChemSketch starts up, you will find many menu commands and toolbar
buttons appear dimmed (inactive). They will be made available as soon as you draw a
structure.

In the ChemSketch window, there are two modes, Structure and Draw. You switch
between them using the buttons in the upper left-hand corner:

Structure | Draw

In the Structure Mode you draw structures and reaction schemes while the Draw Mode
Presents you with the tools for entering text and drawing various graphical objects.

(0 Toolbars in Structure Mode Screen:

Below, you can see the screen with the Structure Mode enabled. The names and
Positions of some of the toolbars are shown.
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?E:hemBasic toolbar

P4

3 [ Structure {oolbar

Reference
toolbar

Atoms

toolbar

Status bar

The Structure toolbar contains tools for drawing and manipulating chemical

O
structures.

o The Atoms toolbar is displayed vertically to the left of the screen and contains
buttons representing atoms, as well as tools for changing atom properties (charge,
valence, numbering, etc.).

Simply click an atom if you wish to display it in a structure.

Workspace is the open area in the middle where structures are drawn.

Colour Palette at the bottom of the workspace allows you to quickly colour atoms
and bonds in the selected chemical structures. _

o The Reference toolbar is placed to the right of the window and contains the Table

of Radicals and various buttons representing ready-made structures and radicals you
can take from the table.

Some useful Buttons in Structure mode:

The ‘Undo’ Button:

It is not uncommon, especially when first using the Drawing Package to make mis

when drawing structures.
This button can be a lifesaver! It resets the ChemSketch screen to exactly what it %

before you made the mistake.
Rado’
B

takes

button next to it becomes

No‘te; As soon as the 'Undo’ button is click
undo too many steps:
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The 'FU

o)

Thi's allows you to see how the page will look in a printout. If necessary, move the
objects on the page to arrange them properly.

The ‘Template’ button:

I| Page’ button:

sl
Lasant

This- button brings up a list of templates such as Lewis dot diagrams, Lab equipment,
Orbitals, Hazard Symbols etc. which you can copy and paste into a ChemSketch® page.
The ‘Optimization (or Clean)’ button:

This will optimize bond angles etc,, after you have altered a structure so that it looks
more viable.

The ‘Delete’ button:

This allows you to ‘rub out’ parts of molecules or even whole structures as required.

The ‘Selector’ button:

Lasso selector Rectangle selector
Select atoms, bonds and fragments by using either of these selectors.

To deselect fragment(s), click anywhere on an empty space.
The ‘Flip’ buttons:

These will flip the structure Top to Bottom or Left to Right.
The ‘Move’ buttons:

Move Rotate/Resize 3-D rotate
Once a fragment has been selected, you can iy
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The ‘Drawing’ buttons:

Draw Chains

Draw Normal Draw Continuous
n the format chosen.

These allow the structures to be drawn i

v%
The ‘Bond’ buttons:

These allow stereo bonds

or coordinate bonds to be drawn.

The ‘Reaction’ buttons:

Y|

Use these to give the plus sign and the arrow in equations. Clicking on the small white
rectangle in the bottom right corner of the arrow icon gives various types of reaction

arrows to choose from.
BRI Bt B4l
1) ¥ Sz ¥

The

This allows you to change the orientation of groups in a chain.
The ‘3-D Optimization’ button:

This allows you to rotate a structure in 3-D.
1. Making all carbons in a chain visible:
Proceed as follows:

o Choose the ‘Select/Move' button.
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&.9. Propane can be changed from

7\

H,C  CH,

- Drawing cyclic structures:

to

CH,

A

H,C

CH

3

Using the Reference Toolbar: This is placed to the right of the window and contains

the Table of Radicals and various buttons representing ready-made structures and

radicals you can take from the table.

0
Make common structures or radicals readily available, left click on th_

the Fg key.

This
Will open a window containing the Radicals and Structures available!
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Point the cursor at the required button and left click. The button will be added to the list
below the icon (this can hold up to 12 buttons).
To remove a button from the list, double-click on an empty space on the toolbar.

To use the structure, click on the icon to choose it and then click on the page to place it.
Displaying the name of a structure:
Ensure ‘Structure Mode' is selected. Now choose the ‘Select/Move' button. Drag the
mouse over the structure to highlight it. Now 'Menu', ‘Tools’, and when the drop-down

menu appears, click ‘Generate Name from Structure’ e.g.

C Docucents ACDAabs b
A 1 ’24,",, s “
;NJ% V!

Cesgies B
| 1% €l
M e A

LU enshReg
s (‘,’r+hﬁ+‘? b ko iidial i

s Berearbesng . rAk

e CH

. Caverate SHLES Norwn i

- St e g from SHILES !

3 Y g 7 13 i

ey TR gl Ot O OHy

‘The window closes and the name is displayed under the

possible on full structural formula as well.
CH,

Hy,C—CH=C—CH,—CH,
3-methylpent-2-ene-
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4. Displaying the molecular formula, formula weight, composition etc.:

Ensure ‘Structure Mode' is selected. Now choose the ‘Select/Move’ button. Drag the

mouse over the structure to highlight it. Now ‘Menu’, ‘Tools’, and when the drop-down
menu appears, click the last one called ‘'Calculate’.

SHAS OGS

L 2 ; T %7
AP
~ :
Redttiar
DIt

AN MUK Y
Wk R

TanY SN £y eas

Raerne TR by Sy

T Bwvekn o Py
d

This will open another m y dragging the

mouse over and highlighting it.

i

When the mouse button is released, the window closes and the type of window shown
opposite opens. . ) )
Click the box ‘Copy to Editor’ and the calculation will appear beside the structure.
This can be repeated again and again for all the required calculations, and the results
dragged about and placed to where you wish on the page.
e.g.

CH, 3-methylpent-2-ene
L) e B s Molecular Formula = C¢H
H,C—CH=Cr=CH;=-C Formula Weight = 84159
omposition = C(85.63%) H(14.37%)
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(II) Toolbars in Draw Mode Screen:
Below you can see the screé
some of the toolbars are shown

n with the Draw

A5 AG-“&"'@ b'

IR &

Mode enabled. The names and positions y

Drawing Structures

Drawing

N H
" H

This is Asparagine

Editlng toolbar —
l Workspace‘J
Colour >
palette e S

Drawing
toolbar

Fvagtion Cowmdinate

' Reaction Mechanism
Diagram

m{ r| Color Palette lﬁ

Status bar [wedtes |42 page 135
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pdicind ‘ . . T ,
Mcal ar contains a series of words. Each.word !mks to a list (‘'menu’) of related
f enul bds for working in the ChemSketch window in Draw mode.,
0 an
com

olbar includes tools that are present in both Str
general |t2|p you with tasks general for both modes such
0; V'v;;” /:edoing operations, copying and pasting,
UHdotlin% various templates. :
inser toolbar is only present in the Draw mode incor
Ed't'-ngmting drawn graphical objects. '
manipy toolbar displayed vertically to the left of the screen contains buttons for
, Dra"‘f'n“ggvarious graphical objects and text. Rt NN
| : i s are drawn an
S\rfi\:kspace is the open area in the middle where graphical objec

texlt is ty'fae‘i'tte at the bottom of the workspace allows you to quickly colour selected
Colour

objects. . .
me use{‘ul Buttons in Draw mode:
{ g

ucture and Draw modes

as saving, opening files,
zooming in and out, as well as

porates tools for editing and

<

(e]

0

S0

sed in the same way
Th’ % displayed down the left hand side of the fﬁresegeacrggdairtz;
. e
as the;esaereairs v\;iﬁd% by clicking and dragging to draw
The ‘Draw arrow’ button:

Use this to draw an arrow.
he ‘Text’ button:

5

Use this to type text in a page.
he “Edit Text’ button:

B

"W

. Use this to edit text.

: ' : e he setected item,
i ove/Rasie Butt(,nt\ma or shape to highlight it. To move t e
Once selected, click on a struc

3 !

n, move the mogse,
oft click inside the box, and while holding dowr:):::teoglg;?lvn:
Sucture, click on a handle, hold the left mouse
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& Finally, draw the mechanistic arrows by using a combination of the ‘Arrow’ and "Arc’

tools under the ‘Draw’ tab. Once this is done, grouping the structures is
recommended.
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c°py'“9 and Pasting from the 3-D Viewer: Into a Word® document
© Choose ‘Menu’, ‘Edit, and choose ‘Copy".

© Open the Word® document and ‘Menu’, ‘Edit, ‘Paste-Special’. This will open
another window.
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¥ paste:

CREENNER

hged rserts the conterits of the Clipboard as a picture,
f& This Farmat is better than Bitmiap for printing to High

Picture occupies the lesst space on disk and displays
the quickest in Word.

H
!
5
qualky printers. Of the Format optiors avafable, §
|
H

Choose ‘Picture’ and click 'OK'. . .
Your structure will now be pasted into the new document as a picture, which can be

cropped, formatted, moved and resized as required.

O

moved about and resized in the slide.

Applications:

Drawi%

Open the PowerPoint® slide and ‘Menu’, ‘Edit’, 'Paste’. The object can now be

1. ACD/ChemSketch is software for drawing in Chemistry from Advanced Drawing in
Chemistry (Advanced Chemistry Development, Inc.) designed to be used alone or
integrated with other applications.

2. ACD/Chemsketch is primarily for educational use. With this program it is possible to
draw and create chemical equations, diagrams, and chemical structures and schemes
of various molecular entities and chemical reactions.

3. Itcan be used to develop reports and presentations.

4. ACD/ChemSketch has the following capabilities:

() Structure Mode for drawin

(b) Draw Mode (Draw Mode) for text and graphics processing.
(c) Molecular Properties calculations for automatic estimation of:

5. ACD/ChemSketch can either stand alone as a drawing
"reference” for other ACD softwares such as NMR Predictor.

Formula weight;

Composition in percentage;

Molar refractivity;

Molar volume;

Refractive index;

Surface tension;

Density;

Dielectric constant;

Polarizability;

Monoisotopic, nominal and average mass

g chemical structures and calculating their properties.

6. There are additional ACD software parts that are accessible through the interface.

e ——

’
—_y
P



'

| Chemistry 8.18

| Medicing

/ EXPERIMENT 8.2
s Draw chemical structure and reactjon by using ChembDraw,

Theory: The CO_mPUter_ program Ca!nbridge Soft's ChemDraw i a user-friend| d
dustry leader in chemical and re:actlon drawing. In addition, it analyses pro ert'y' an

lrovides sophisticated search and information functions, FefHes ang
chembDraw is scientifically intelligent drawin

e.g. Benzene, Imidazole etc.) and menu, respectively.

The cost of entry level commercial ChemDraw Prime 16.0 is about x 9.56 lacks with
perpetual license and its academic price is about x 010 lacks with one-year license.
ChemSketch is a comprehensive structure editor with a variety of tools and functionality
that ease the communication of scientific and chemical information.

Draw molecular structures, generate structures or copy/paste from ChemDraw.

Easily and quickly include known molecules.

Insert pre-drawn templates of amino acids, aromatics, steroids, sugars, and more.

Search the Dictionary of >170, 000 systematic, trivial, and trade names.

Easily draw reactions and complex chemical schemes (including biotransformation maps)
Use graphical templates and tools to communicate chemistry and chemical biology
concepts (e.g., chemical bond types, Lewis structures, molecular orbitals, Newman
Projections, peptide seguences, and more).

Import and export structure files in a variety of standard file formats.

Draw complex schemes, such as biotransformation maps, with ease.

Draw organic molecules, organometallics, biomolecules, polymers, Lewis structures, 2D
and 3D structure representations and more. Calculate quanti_ties for chemical reactions
(with automatically calculated chemical formula, molecular weight etc.?. |

ChemDraw is a powerful, yet easy-to use, tool for producing chemical and biological

drawings. You can create your own drawings or use those provided in the library of
dvailable templates,

PfOCEdure;

[ latform.
© Open the online tool from URL or by using goog!e p
° Navigate to Online>Browse PerkinElmer Technical Support. The Tech
Web page opens.
® Click Desktop Support.
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nching ChemDraw

Installing and Lau

o In ChemDraw, press or havigate to Help>Contents
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Toolbars in ChemDraw:

e}

By default, the use
M " e
document status bar. The user interfac
o thel®
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B L =il gy Magnification
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Bad Search Toolbar
o &1 BioDraw Toolbar
NQp
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N i Main Toolbar 1
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AN § Status Bar
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duced, such as Search, Structure, Curves, Windows,

and Biopolymer toolbars. To display or hide a toolbar, select it in the View menu. A
check mark appears next to the toolbar name when it is visible. You can also hide the
toolbar by clicking on the X' icon on the upper-right corner of the toolbar.

The Main Toolbar: The main toolbar includes the tools most commonly used for
drawing structures. These include all selection and bond tools. You can open other
toolbars from the main toolbar. Navigate to View>Show Main Toolbar.

Tearing off Toolbars: Some tools on the main toolbar have other toolba’
associated with them, These are indicated by a small black triangle in the lower right
corner. For example: You can “tear off’ these smaller toolbars and place them

anywhere on your screen,
To tear off a toolbar: Double click on the main toolbar t

aDnd tl.1en drag it to where you want it on your screen. K
: ‘:‘k;gg a.nd Floating: You can dock or float any standard toolbar. When you 9 r
i ?:) 5 taf, fltt:ecgmes attached to the drawing window. The floating toolbars aPp:‘;
(o) e . . an
£ ocument window and you can move them around In the dr
Double-clicking the toolbar restores it to t

Several new toolbars are intro

o show the secondary tools




select Float Toolbar.
gioDraw Toolbar: The BioDraw toolbar
and biochemical elements to your drawi

ngs.
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to umbering Reaction Schemes:

° You can automatically number molecules, sequentially, in reaction schemes. To set
your Numbering scheme:

L Select File>Document Settings, and then click Reaction Display from the options

on the left,

Choose Roman, Arabic or Alphabetic from the Numeric Style dropdown list. You
¢an also select the starting number from the Starting From: field.

3. Click oK.

Touse autonumbering:

2' Draw your reaction scheme.

Select your reaction using the Edit>Select All menu option or the marquee or
lasso tools,

Select Structure>Autonumber Reaction. Roman nu
display beneath your molecules.




Pracliee Mol e NH; N\)J\
H SRR oH |,
. Vo' ¢ (3)
\Lg ) Glycine
Arginine
(1) Amldinotransferase
Ornithine
H.N s-Adenosyl
2
NH
Guanidinoacetate S-Adenosy!
(4) Methyltransferase hemocystenic
H,N N/\n/ 2
| o
Creatine
\N -
)\ o ADP + H ADP
HN N Creatine kinase
Creatmme ATP ATP

(5)
K NH
HN /U\N/\/\H/OH
| o

HO— P— OH
|l
O
Creatine phosphate
(6)

To remove auto numbering:

1. Select
your reaction using the Edit>Select All menu option or the marquee of lassO

tools.
2. Select Edit>Und
0 Auto nu
structure, mber Reaction. The auto numbering removes from the
Page Layout:
o Object alignment,
age size oriams ] ,
page size, orier Fat nd other factors affect the presentatlon

quality of your document.
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Drawing Bonds

ChemDraw

and other objects are drawn. You can configure the
for a particular object as follows:
o>Document Settings and select the Drawing

Drawing Settings:

Drawing settings a

drawing settings for an enti

o For the entire documen
category.

o For an object, use the Object Settings dialog box. Changes you make to the drawing
settings affect the active document window only. You can save drawing settings in
style sheets. To apply settings from other documents to your document, navigate to
File>Apply Document Settings.

o The various optionsgvailable under drawin

1 Setti

ffect how bonds
re document or
t, navigate to Fil

g category include:

" DA

Hords
Pttt | socrg @ wmottegt[ T
o

yargin Widt: 5,628 Hash Spacing: | 0.0375 0

m; ” 2
s [ fdeyess

L Vit el :
At Borsdles
W Shava Qusy Iniictons ¥ Shoe Query Indcsiors
™ Shom Stersachemistry ™ show Stereochemistry
¥ thow Enhanced Sieeochemistry ¥ Show Reaction Indicators
I Shov Ao Warbiess

Dispay Unis: iches =] | ok | Concd ||

Bond Spacing:
o Sg{:} the fjistance between the lines in double or triple bonds. The distance i set
either as: The percent of the length of the bond (between 1 and 100). This allows for
proportional spacing if different bond lengths are used

10% 14% 18%
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| Pfﬂc“
;s jold Wset the width of the line used when polq and wed
i

0 =% i st be greater than the L ' ' .
idth setting mu g Ine Width setting. The end of
:/i\/meS T B width: g Ot a wedge is 1.5

- Line W'g::];he width of all bonds, lines, and arrow
Margin Width: Change the amount of s
erase portions of the bonds to which
determines the amount of white spac
crossing.
terminal Carbon Labels: :
o By default, ChemDraw does not dis

labels:

1. Navigate to File>Document Settings.

2. Select the Atom Labels category.

3. Select Show Labels On Terminal Carbons. See figure below:

idth:

heads in the drawing,

Pace surrounding all atom labels that will
they are attached, The margin width also
€ surrounding the front bonds in 2 bond

1% o
| 0

play terminal carbons. To display terminal carbon

Tet Cantors | | Arl
i‘f Andalus
Reaction Display A gs o
Colors Aparay
Arabic Transparant
Effects: Line Spading: Basseline Style:
™ Underine £ Automatic §me§a v
¥ Variahle

" Fiedat Om :

™ Show Labels On Termingl Carbons
I™ Hide Impticit Hydrogens

Display Units: }inches :j - W Cancal |

Analysis and Properties: . N l
' ties into your drawing. You can also
° fundamental structure proper . ‘
\r(:rtjar;antl"?::;e roperties when desired. For instance, you may consider renamn;g
"Moleceular We?ght“ to “MW" to save room on the page. The chan%eih)éo:n:}asé
apply only to the properties you paste in your drawmg.dTr%e r;ir::sel e namesyof

and Chemical Properties dialog boxes remain unaffected. To g

the properties: Izt
1. Navigate to File>Document Se g |
2. Select the Property Labels category. See figure below:
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In the Analysis window, select the property to r'ename.
Click Edit Label and type a new name in the Edit Label text box.
Type the new name, and click OK.

Repeat step 4 for other properties.

7. Click OK.

Atom Labels: RER
o Use the Centered, Flush Left, Flush Right, Stacked Above, or Automatic justifications

to create labels that identify atoms and functional groups in your chemical structure

without obscuring bonds or other atom labels.
o Examples of the act)om label justifications are shown below.
e

M
CH,
e,
Blon il 4
(@) i N

(b)

Click OK.

DU w

2 2
OMe OMe
o (@

* Atom label justification,
(A) Stacked above: (B) Centered; (C) Flush left; (D) Flush right.
Objects |
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To draw a ring:

bar, select a ring tool.

1. From the Main tool ont the ring.
2. Click and drag in the document to orl
) “H e bt par RS B ; (R ,.
Al
o
Chains: 3 ] ’
c  You can draw hydrocarbon chains using either the Acyclic chain tool or the Snaking
chain tool. Use the Acyclic chain tool to draw straight hydrocarbon chains.

1. Select the Acyclic chain tool.

2. Click and drag in the document window in the direction you want the chain to
grow. The number at the end of the chain indicates how many atoms you have
drawn.

Arrows:

o

You can use arrows to show the conversion of reactants to products and to indicate
electron flow. You can customize arrows not only for length and angle, but for
arrowhead width and shape. You can also drag an arrow from its middle to create an
arc of any length. When you create an arc, the angle of the arrow is modified.
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Finishing up structures

ChemDraw

Checking Structures:

o You can check the chemistry of a selected structure, part of a structure, or caption (in
Formula style) with the Check Structure command. The structure is checked using

normal valences, elements, and defined nicknames.

o To check the valences of all selected atoms in a structure:
1. Select a structure, part of a structure, or caption.

2. Navigate to Structure>Check Structure. If a structure is incorrect, a message

window appears, for example:

[T o Rcmons« S0 Ot © 3
GO GR 0 ZEA0 oo B Lot R feark SRS RC Je 1Y
oW e e T
&3 - BRSO
Ke .

/

3. To continue checking the structure, click Ignore.
4. To ignore all subsequent errors, click Ignore All.
5. To stop checking for errors, click Stop.

BioDraw (Professional Level only):

BinDraw Templates
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Membrane Line:

i w toolbar.
L Select the membrane line tool from the BioDra :

i —eliekfor the default
2. Click and d to draw a membraneé line of the size you want O
5 and drag
size.
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Helix Proteins:
To create a helix protein:
1. Select the Helix Protein tool from the BioDraw toolbar.
2. Drag in the document window, or click to draw the default size

© M Bt NS B s
B>l W i eyt X e SR S 60 B

p—
R e

DNA molerylgs and plasmig maps
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DNA Molecules:
To create a DNA molecule:
1. Select the DNA tool from the BioDraw toolbar.
2. Drag in the work space, or click to draw the default size.

i 73 A
B G DS Qw2 o s e 2 4

1000

Creating a Plasmid Map:

1. From the BioDraw Toolbar, select the Plasmid Map tool.

2. Click in the drawing window where you want the plasmid map. The Insert Plasmid
Map dialog appears.

3. 1In the Insert Plasmid Map dialog, enter the number of base pairs in the map, and
click OK.

The plasmid map is drawn.

Hpal4198) ~ Eagl(4353)

Sall(4346)[ Not(4353)

Pvull(605)

Narl(3989) Pstl(5) Stul(459)

Aatll(3798) Nhel(615)
ECORV(634)

Ncol(774)

4400bp

Apal(1189)
Fspl(3098) Mscl(1330)

Bglll(1359)
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Labels:

In addition to representing atoms,
define. For example, you can assign a label to an un
contract that region to reduce the size of your dra

Labels and Atom numbering ’

N

SN

ChemDraw’

———————
B

Drawing Structures

labels can represent regions of a structure that yoy
important region of a molecule and then

wing. You can then expand the label, to

see the whole molecule. Creating Labels to create a contracted label:

1. Select the area of the structure to contract.
2. Navigate to Structure>Contract Label. The Contract Label dialog appears.

3. Type a label for the contracted structure.

4. Click OK.
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Mass Fragmentation:

Mass fragmentation mimics the molecular fragmentation in a mass spectrometer. When
you apply the mass fragmentation tool to a structure, you cut through the structure,
severing its bonds, and creating fragment original structure. This is not a predictive tool; you
must specify what bonds are to be broken. To fragment a structure, use the Mass
Fragmentation Tool to drag the cursor across one or more bonds. When you release the
mouse button, bonds that you cross are broken.

8 O At e N € &
B BO Ve (exe Batie B fam Do Saned B e W 30

B Gk
RoDUA QYL TBIn . HBHE

s §: N Chosiest Formals: Cl™
S Exaet Mass; 42,08 Chomical Fopart: £,
Prac wss: 3203

@ —

Chemival Paensiebie el
Bxact Masw 4248
Chamient Pormala Cetty™
Fixsot Minas: JR02

S

Cheival Posle: Cig™
vt Mave 22

Chinical Fornnria Colly®
Exoct Klass: 2602

k< s . fownt Dcorant 4%
Mt S8 Yoen Qi Boomaw K Sovime Koy Sem®

& L0 e
“bompieal B . Cherical Farmla: Cglys*
Chemical F rmula; Cytly? etz
o e et Mass: 84.09

Fxact Mass: 39.02

o3

1%



- Drawing Structures

Practical Medicinal Chemistry

Drawing Reactions:

To demonstrate how to draw reactions, we will use this example:

T (ot Arientay  TRNSRE DGNN § ‘ Pakad = o
B 0 Yoo (N Suandr B e N ¢ §§ § E $, % ‘
Bods O falm  AA
R
%
Q r
el
-
- \ Y]
. ) o) »
K 8 YOH
\ "‘ iL\ AR I
NE ’ “
% ® / s — %18
o 2 propences SHYDROXY-IMETHYLPENTA-2-ONS

Stoichiometry Grid:
Use the Stoichiometry Grid to calculate stoichiometric data for a reaction. The grid fills in

as you modify a reaction drawing, and all calculations are done automatically.
To create a stoichiometry grid:
1. Draw a reaction, or open a file containing a reaction.

2. Navigate to View>Show Reaction Interpretation. Turning on Show Reaction
Interpretation ensures the reaction is properly interpreted by ChemDraw. When you

click over the reaction, for example

v , AlCl,
CeHg | + | CHCl [6——6—FO| CHcCH, |+ | cH

e Reactantsin red

¢ Products in magenta

* Anything above and below the reaction arrow in cyan and blue
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"
( M3 . (144
Cole o CHM) e, COHBCH [k
s..~ )
: * [ ¥ TR T
b TS UL, U244 /
- Yos NG i
S R
FEANN
Puriiy
Prosduct 3ass
doles Product Moles
Reactants Products
Formula | CgHg | CHiCI | AICK Eormula CiHgT 5T [T CiH 7 |
MW 7811 50 48 13333 MW 9244 T
Liniting? Yes Np Mo -guivalents
Equivalenis %Complation
Sample Mass 2524 6675 Expected Mass | 481, 1824
%Weight Expected Moles | 50.00wse | 50 00
Molarity Measured Mass
Density Punity
Yolume Product Mass
Reactant Motes | 50.00mmot | 56 00ne: | 50.00wne 1 Product Moles
Reactard Mass | 3.9 2.52¢ 6.67¢ 9 Yipid

Struct-Name (Professional Level):
o ChemDraw includes two features for generating structures and chemical names—

Name>Struct and Struct>Name.
o Collectively, these features are called Struct=Name.
o Struct>Name generates the names of chemical structures using the Cahn-Ingold-

Prelog rules for stereochemistry.
U have drawn.
A
2\ |

o Using this option, you can generate the name of st
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O

o
o}

nvert chemical names into their corresponding chep;, '
chemical names as they are used by ChemiSta
hand and slang of everyday usage, in additios‘
JUPAC, IUBMB, and CAS rules g,

Name>Struct lets you cO
structures. It is designed to interpret
In other words, it recognizes the short .
to recognizing most of the official
recommendations.

Struct>Name: Struct>Name can interpr
means that you can draw a structure and
updates the name when you modify the structure.

Using Struct>Name

To generate the name of your structure:

1. Select the structure.

2. Navigate to Structure>Convert Structure to N

structure.

et a variety of chemical structures, This
Struct>Name will provide its name. It gl

ame. The name appears under the

Chemistry Features:

Structure Analysis:
o You can display the chemical formula, exact mass, molecula

Elemental Analysis:
The percent by weight of each element in the structure.
To open the analysis window:
1.

r weight, m/z, and

elemental analysis for the entire document, a structure, or a part of a structure using

the Analysis window.
Values for selected objects in the document window are shown. If no structure is

selected in your document, values for the entire document are shown.
You can have this window open as you draw in the document. It shows the current

values as you draw, see example below:
7 \\'

W opormulas (gHeOO

¢ Exact Pass: 128410 gon
) Decimals: 2«
pol, Whe  12B.56 T e

s 125,00 {100.0%),
130,00 (32,0%),
120,01 {5.5%),

Elera, &rals €, 56.06; H, 3.82; O, 22.58;
5 4w
pas};e «é 0; 1»;4\4‘

B

SN

KRt

Select the entire structure, or part of the structure. If nothing is selected, the analysis
winc}ow displays value for the entire structure. ,

Navigate to View>Show Analysis Window. The analysis windows displays values for
the parts of the drawing you select, or the entire drawing-i=nathing is selected.
.(Optlonal) Select Paste to add the analysis infg St
information appears as a caption that you can edit.
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H OH
Glucose

Chemical Formula: C4H,,04

Exact Mass: 180.06
Molecular Weight: 180.16
m/z: 180.06 (100.0%), 181.07 (6.9%), 182.07 (1.4%)
Elemental Analysis: C, 40.00; H, 6.71; O, 53.29

The information updates as you edit the structure. You can show or hide the

information:

1. Using any tool, right-click the caption.

2. Point to Analysis, and select or deselect the item to show/hide.

Chemical Properties:

Chemical Property Prediction is a feature supported by ChemOffice. It enables you to
calculate values for a wide range of methodologies; for example, topological descriptors
such as the Weiner index and Balaban index, thermodynamic descriptors such as solubility,
melting and boiling points, and partition coefficients such as CLogP, properties related to

O”ll!l

structure.
ChemNMR (Professional Level):

Using ChemNMR, you can estimate and display proton and Carbon-13 chemical shifts
for a selected molecule.

- IR spectra and other Spectra as well.
Setting Parameters Values in ChemNMR.

Use the ChemNMR option in Preferences dialog to
 ChemNMR. See the example below:

v YSYPR, v
Sedeerss {[,:‘:’7_:(;1‘

Lo 4 .t’»z
ez Framgmrsy:
{ IV bty wpprens vshatd e rpes amenived patsy

19 tpwhty oo AT tngms rreriind dara
Cntenes fre Va0 ..

Y ey wpmimm BRI el des
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Practical Medicinal Chemistry ‘/__'_,3_4,3/' Drawing Structures
To view 1H or 13C NMR information:

1. Select a structure.

2. Navigate to Structure> Pr

s or Predict 13C-NMR Shifts.

edict 1H-NMR Shift
cule with the estimated shifts and displays the informatjop,

ChemNMR redraws the mole

and line spectrum in a new window.
n
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Special Features:




Drawing Structures ...

practical Medicinal Chemistry 1

Chemists can also save time and increase data accuracy using ChemDraw to

o}
generate spectra, construct correct  IUPAC names, and calculate reaction
stoichiometry.
o A powerful set of tools to handle substructural query types (such as R groups,
atom/bond/ring types, and generic atoms) ensures that compounds are quickly and
accurately located by searches, no matter how they are stored in commercial, public
or in-house databases.
- Available for both Macintosh and Microsoft Windows.
Result:

~ Drawing of chemical structure and reaction schemes by using ChemDraw was done.
i
L,— VIVA VOCE

1. Enlist the online tools for the drawing of chemical structures and reactions.

2. What are the uses of computer programmes in pharmacy?

3. Explain the procedure for starting ACD/ChemSketch.

4. Explain any five buttons in Structure mode and draw its icons.

5. Explain any five buttons in draw mode and draw its icons.

6. Enlist the different molecular properties which can be calculated using ChemSketch.
7. Explain the toolbars in ChemSketch.

8. How you can draw the structure of Benzene by using ChemSketch?

9. Explain the application of ChemSketch.

10. How you will draw reaction mechanisms by using ChemSketch?

11. How you will install ChemDraw?

12. How you will draw structure using ChemDraw?

13. How you will colour the particular atom in a structure using ChemDraw?

14, Explain the different Drawing Settings in ChemDraw.

15. Explain BioDraw (Professional Level only).

16. How you will draw DNA Molecules using ChemDraw?

17. Explain the Mass Fragmentation.

18. Explain the ChemNMR (Professional Level).

19. Explain the different parameters oserved in Chemistry Features in ChemDraw.

EEE




. RAJMATA JIJAU SHIKSHAN PRASARAK MANDAL'S I

COLLEGE OF PHARMACY (B.Pharm.) i

Approved by PCI, AICTE, Govt.of Maharashtra & DTE

Affiliated to Savitribai Phule Pune University, Pune
DTE Code:- 6382

T SRISPM ==

RJ
Sﬂhs
anna

University Code:- CPHPO13150

Cammtted fov Encetipuce in Eduontinn
Certified by ISO 9001-2015,

Recognised as Green Educational
ISO : 14001-2015

Campus
Hon.Shri. Vilasrao V. Lande Hon.Shri. Sudhir V. Mungase Hon.Shri. Ajit D. Gavhane Dr. Kishor S. Jain
President Secretary Treasurer Principal
2) You Tube Channels
Tl s g vane dea, Shics 31t Wit
Gat No.101/102, Moshi-Alandi Road, Dudulgaon, Pune. 2 ;
Post--Alandi, Tal.: Haveli, Pune-412105, Maharashtra (India) Commiitted for Excellence in Education
Phone : (020) 20280280, 7447763086, 9422322070

@ : www.rjspmpharmacy.com

Q@ O ® ra © /rispmpharmacy

Email: rjspmcop123@gmail.com



RAJMATA JIJAU SHIKSHAN PRASARAK MANDAL’s

COLLEGE OF PHARMACY

Approved by AICTE & PCI New Delhi, DTE, Govt. of Maharashtra &

Affiliated to University of Pune

Gat No.101/102, A. Post-Dudulgaon, Post-Alandi, Tal-Haveli, Dist-Pune - 412 105
E-mail: rjspmcop123@gmail.comWeb: www.rjspmpharmacy.com

Univ Id: PU/PN Pharm/286/2007

College Code:1081

KNPM@

DTE Code:6382

GE OF py,
oo\)ﬁ 40%

= o

Committed forn Excellence in Education

v,

)

INNS

YouTube Channel of Faculty Members

Sr. Channel . . No. Of
No. Name of Faculty Name Topic Link Videos
Emerging Trends in Drug | https://www.youtube.com/w
1. Dr. K.$. Jain Kishor Jain Discovery atch?v=0ArNDnc7-X0 28

IR Spectroscopy Part 5:

https://www.youtube.com/w

Question Answers & e
Assignments atch?2v=C7AwTwgmy O
Infrared Spectroscopy

Part-4: FTIR Theory ,

https://www.youtube.com/w

Instrumentation and atch?v=ImYf aUpRYo
Applications of IR.

Infrared spectroscopy- https://www.youtube.com/w
part-3‘: Instrumentation & atch?v=CXdOPuP525¢
Handling

New Drug Discovery | https://www.youtube.com/w
Methods & Tools Part | atch?v=a7yggDfiX4l
Polycyclic Aromatic

Hydrocarbons (PAH) Part
4 Dr K Jain

https://www.youtube.com/w

atch?v=PuvRI6aU7RFk

PAH 3 Phenanthrene Dr K
S Jain

https://www.youtube.com/w

atch?v=W19fxpc3My4

PAH 2 Anthracene Dr K S
Jain

https://www.youtube.com/w

atch?v=dnMRkRjgwy O

PAH 1: Napthalene Dr K S
Jain

https://www.youtube.com/w

atch?v=2avsx IBKtI

IR Part 2 The IR Spectrum

https://www.youtube.com/w

atch?v=fqdCOT8XHhO

InfraRed Spectroscopy:
Part | Theoretical Aspects
Dr K S Jain

https://www.youtube.com/w

atch?v= cJpY4fVU g

Benene and Aromaticity-
Part 1 Struture & Orbital
picture Dr K S Jain

https://www.youtube.com/w

atch?v=ppISNKWad¥Yk

Benene and Aromaticity-
Part 2 Resonance &
Aromaticity Dr K S Jain

https://www.youtube.com/w

atch?v=UfIF4P-Jifg

Benzene & Aromaticity
Part 5- Selected
derivatives & MCQs

https://www.youtube.com/w

atch?v=rz6 wPUGTXYo

Benzene and Aomaticity -
Part 4- Orientation of
substitution in
monosubstituted benzenes

https://www.youtube.com/w

atch?v=10-7Emiji-ps

Benzene and Aromaticity
-Part 3-  Electrophilic
Aromatic Substitution by
Dr K S Jain

https://www.youtube.com/w

atch?v=61HAG6tAyi10

IUPAC Nomenclature of
Organic Compounds by Dr
K S Jain

https://www.youtube.com/w

atch?v=iQ53eBqgdGCk

Classification of Organic

https://www.youtube.com/w

Compounds- By Dr | atch?v=lg68qZnGt 8
K.S.Jain
Career Opportunities in | https://www.youtube.com/w

Pharmay

atch?v=iicaCdoroVQ

Molecular modeling-
CADD basics -Dr K S Jain

https://www.youtube.com/w

atch?v=A55vEBdXfeQ
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(S Y B Pharmacy Sem IV)

:‘:;. Name of Faculty C:::::I Topic Link ciod';:
QSAR (Hansch's LFER) | https://www.youtube.com/w
Explained Dr K S JAIN atch?v=8u7htORWWrA
DRUG DESIGN | Earlier | https://www.youtube.com/w
Approaches Dr K S Jain atch?v=NXIYYjmJ8p8
Fibonnaci in Drug Design https://www.youtube.com/w
atch?v=kywOT8-uXks
3D QSARDr K S Jain https://www.youtube.com/w
atch?v=9wOUAzTXeZo
Dr K S Jain : Aldehydes & | https://www.youtube.com/w
Ketones atch?v=rK8-WLIgSEw
Dr K S Jain : ANTI- | https://www.youtube.com/w
TUBERCULAR AGENTS atch?v=LIAIVYIZoT4
Dr K S Jain- | https://www.youtube.com/w
ANTIMALARIALS atch?v= 6m5Yw78rQs
Pharmacognosy of Jute (S | https://www.youtube.com/w
2. Dr. }).$.Dhumal Jeevan Y B Pharmacy Sem IV atch?v=vUMG2kX0X69 31
Dhumal Pharmacognosy of Hemp | https://www.youtube.com/w

atch?v=052e0OswqwTc

Pharmacognosy of Cotton
(S Y B Pharmacy as
pePCl syllabus

https://www.youtube.com/w
atch?v=-j\VqeZIDnnl

How to check B.
Pharmacy provisional
merit list ? Next step after
checking the provisional
list

https://www.youtube.com/w
atch?v=-vDouTnD2rE

AFTER SUBMISSION OF
ONLINE APPLICATION
VERY IMPORTANT STEP
B Pharm First & Direct
Second Year CAP 20

https://www.youtube.com/w
atch?v=LnlIG8Kot7w

filling and confirmation of
option form for post HSC
diploma courses

https://www.youtube.com/w
atch?v=33InL5YugXo

What is TFWS? Complete
scheme details

outube.com/watch?v=Gull6K
Q71Xg

B.Pharmacy/ Pharm D.
Admission Activity
schedule 2020-21

https://www.youtube.com/w
atch?v=AjjwrZOGTus

How to view Provisional
merit list (Post HSC
Diploma courses) & what
to do in case of Grievance?
D Pharm (Post HSC
Diploma Courses) activity
schedule 2020 21

https://www.youtube.com/w
atch?v=)JwONFzF67Fg
https://www.youtube.com/w
atch?v=sS60IEMZarM

B Pharmacy eligibility
criteria from 2020-21

https://www.youtube.com/w
atch?v=owCqg6Eajxqg

Best/Top 10 Pharmacy
Colleges in Maharashtra

https://www.youtube.com/w
atch?v=QUFJAIkmBCA

World Pharmacist Day

https://www.youtube.com/w
atch?v=Xg1Zd-QpYPA

Top 10 Richest Indian
Pharma Entrepreneurs,

https://www.youtube.com/w
atch?v=0KG20Q5sGCo4

Dr. K. Anji Reddy,
Founder, Dr. Reddy's
Laboratories, Pharma

https://www.youtube.com/w
atch?v=w54wKp1zRRg
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:‘:;. Name of Faculty C:::::I Topic Link ciod.eoo:
Success Story 1, Always
Dream Big
D.Pharmacy https://www.youtube.com/w
atch?v=pNIFdTGINsA
Teacher Day Wishes https://www.youtube.com/w

atch?v=QUFJAIkmBCA
Post HSC diploma Courses | https://www.youtube.com/w
Dates extended for | atch?v=BrwOu9slrrk
document verification and
online application till 10
sep

D Pharmacy  Course | https://www.youtube.com/w
Information (Duration, | atch?v=eCKAXNskR20Q
Course of study,
Examination, training etc)
Allotment List, Seat | https://www.youtube.com/w
Acceptance, Auto freeze, | atch?v=ySAOulOFE2E
Freeze, Betterment, CAP,
Post HSC Diploma, 2020~
21

What is next after | https://www.youtube.com/w
Declaration of Provisional | atch?v=aJpGk_MC9Js

merit list & Submission of
Grievances?
PostHSCDiploma

Dates extended for Post | https://www.youtube.com/w
HSC Diploma courses CAP | atch?v=y3Hxy)X-Qjk

2020 (D. Pharm, HMCT &
SCT)

Process for Option Form | https://www.youtube.com/w
Filing and Confirmation | atch?v=GSz474-xetc

for Post Hsc Diploma
courses 2020

Fees Structure for | https://www.youtube.com/w
Government and Unaided | atch?v=aClcsEKeeDc
Private institutes, Post
HSC Diploma, D. Pharm,
SCT, HMCT

How to Search College | https://www.youtube.com/w
fees online? (Pharmacy, | atch?v=00-O5p 37Gk
Engineering, Medical and
Agriculture)

How to send e-grievance | https://www.youtube.com/w
after verification of | atch?v=Zhe-zUnEmbE
documents (e-scrutiny) in
Post HSC Diploma courses
>

Cut off list for D. | https://www.youtube.com/w
Pharmacy. HAT  HIT atch?v=0qQ 3cFuxPVY

K| crero) ST o I = L
uyax ffesd &n

L. D Pharmacy, how merit | https://www.youtube.com/w
list is prepared? Post HSC | atch?v=9UG2Ju6GPNg
diploma courses
Centralized admission
process
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Sr.
No.

Channel No. Of

Name of Faculty Name Topic Link Videos

Post HSC Diploma courses, | https://www.youtube.com/w
What is next step after | atch?v=mRnixBIHFdA
document verification?
Post HSC diploma | https://www.youtube.com/w
courses(D.Pharmacy, SCT | atch?v=LRfHjpZ89nY
& HMCT) Document

verification 4, @ SHeft
B ?

POST HsSC Diploma | https://www.youtube.com/w
Courses CAP 2020 | atch?v=AgPR3e2415A
faamait sffFaRa o
WRuggal a1 TSt
TAR B

Synthetic Antibacterial | https://www.youtube.com/w
3. | Prof. A. N. phuge Ashish Phuge | Agents - Part 1 atch?v=cleHhFD1dSO 20
https://www.youtube.com/w
atch?v=a8kTeD9IxZc
https://www.youtube.com/w
atch?v=2Ww59PS gMw
https://www.youtube.com/w
atch?v=Dk4hwkOHifQ
https://www.youtube.com/w
atch?v=RVYLigYHpRo
https://www.youtube.com/w
atch?v=f-qBFprRlhk
https://www.youtube.com/w
atch?v=1qgSO7CCY0X4
https://www.youtube.com/w
atch?v=ncj8jLO1cTY

. . https://www.youtube.com/w
Antiameobic Drugs atch?v=YSCfPys190k

Autocoids

Fats and Oils

Cycloalkanes

Macrolide Antibiotics

Polypeptide Antibiotic

Antitubercular Agents

Aminoglycosides

https://www.youtube.com/w
atch?v=CVuNKf8IPKE
https://www.youtube.com/w
atch?v=VwolYDjP408
https://www.youtube.com/w
atch?v=DroHV6bp-Ms
https://www.youtube.com/w
atch?v=6LToiy5YRoU
https://www.youtube.com/w

Isoniazid

Beta Lactamase Inhibitors

Antileprotic Drugs

Tetracycline Antibiotics

Flucytosine atch?y=mTBSXM-fWsO
https://www.youtube.com/w

Azoles atch?2v=UxZXiVyFriw

Polyene Antibiotic https://www.youtube.com/w

atch?v=W SSvEe8Fv4
https://www.youtube.com/w
atch?v=VgO7UrdoLLY
https://www.youtube.com/w
atch?v=89trUvhlfxE
https://www.youtube.com/w
atch?v=aPyEEUEFQWE
https://www.youtube.com/w
Antifungal Agents atch?v=bYh3tRB_olU

Antiviral Agents

Anthelmintics

Chloramphenicol

https://www.youtube.com/w
atch?v=pmcOkRQOB59Iw

rchana
Thikekar

4. | Prof A.K. Thikel

IR spectroscopy
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E- Library
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Maharashtra, India

Rajmata Jijau Shikshan Prasarak Mandals College of Pharmacy. Dudulgaon,
Maharashtra 412105, India

Lat N 18° 40" 31.1124"

Long E 73° 52" 39.27"

18/03/:3;‘03:00 PM

Computer/Language Laboratory

A~
F. e
-

0
Q GPS Map Camera

Pune, Maharashtra, India
MVGG+6M5, Dudulgaon, Maharashtra
412105, India

Lat 18.675304°

Long 73.87737°

11/10/22 10:45 AM GMT +05:30

PRINCIPAL
*ajmata Jijau Shikshan Prasarak Mandal's
COLLEGE OF PHARMACY
Dudulgaon, Pune-412 105.




RAJMATA JIJAU SHIKSHAN PRASARAK MANDAL’s

COLLEGE OF PHARMACY R

< e
5. "o
G 2 Approved by AICTE & PCI New Delhi, DTE, Govt. of Maharashtra & ] g
Affiliated to Savitribai Phule Pune University
‘ ‘ Gat No.101/102, A. Post-Dudulgaon, Post-Alandi, Tal-Haveli, Dist-Pune - 412 105 s & o i
Tel: 020-27185566, Fax: 020-27185544, E-mail:rjspmcop123@gmail.com Web: www.rjspmpharmacy.com
UnivId:PU/PN Pharm/286/2007 College Code:1081 DTE Code:6382
oy e o
ICT Facilities
Maharashtra, India
Rajmata Jjau Shikshan Prasarak Mandals College of Pharmacy, Dudulgaon
Maharashtra 412105, India
LatN 18° 40" 31.1124"
Long E 73* 52" 39.27
18/03/31 03:03 PM
LCD Projector in Classroom
r p n OPS Map Camera
- N 4
Pune, Maharashtra, India
MVGG+6MS5, Dudulgaon, Maharashtra 412105, India
Lat 18.675284°
Long 73.877359°
27/06/22 01:16 PM
éb\.a Sijay )
Ay N ()
Smart Board x| PH ‘“41,
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Sat 11:27:35

DS-7AT16HQHI-K1(836385577)-camera 12

Cancra 12

2836385577

CCTV Camera footage
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Rajmata Jijau Shikshan Prasarak Mandaf's College of Pharmacy, Duduigaon,
Pune
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Home Page !
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Assignment Page

Manage Page

@ crtera s

PRINEIPAL
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Details of bandwidth of internet connection

Sr. Name of service Name of service Details of service
No provider
1 Bandwidth of internet Pune teleinfra Pvt. Ltd. Leaseline 100 Mbps
connection 1:1

Maharashtra, India
Rajmata Jijau Shikshan Prasarak Mandals College of Pharmacy, Dudulgaon
Maharashtra 412105, India
Ra]rnata J‘Ja LatN 18° 40" 31.1124"
SIRTTIEIANE : LongE 73° 52'39.27"
Google | 26/06/2111:35 AM

Rajmata Jijau Shikshan Prasarak Mandals College of Pharmacy, Dudulgaon,
Maharashtra 412105, India
/ LatN 18°40'31.1124"
Long E 73° 52' 39.27"
26/06/21 11:38 AM

Cable network of internet in
office

Cable network of internet in
Computer Lab

Maharashtra, India Maharashtra, India
s Rajmata Jijau Shikshan Prasarak Mandals College of Pharmacy, Dudulgaon, Rajmata Jijau Shikshan Prasarak Mandals College of Pharmacy, Dudulgaon,
Maharashtra 412105, India

Maharashtra 412105, India
REIMEIEN]IE] | LatN 18° 40 31.1124" Rajmata Jija, [ERECELEIRIEZY
G Pri%arak IWBl " Long £ 73° 52 39.27" G IRVl Long E 73" 52' 39.27"
oogle 26/06/21 11:37 AM oogle 26/06/21 11:36 AM

Connection of cable to
router in computer lab

Connection of cable to
router in office

PRINCIPAL
*ajmata Jijau Shikshan Prasarak Mandal's

COLLEGE OF PHARMACY
Dudulgaon, Pune-412 105.
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An 1SO 20012015 Certified Company.

Recognized by Govi. of Andhra Pradesh under innovation anc
Startup Policy.

Recognized by DIPP, Ministry of Commerce & Industry,
Government of India.
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MEMORANDUM OF UNDERSTANDING
BETWEEN
VMEDULIFE PRIVATE LIMITED
AND

RAJMATA JUJAU SHIKSHAN PRASARAK MANDAL’S COLLEGE OF
PHARMACY, PUNE

REGARDING IMPLEMENTATION OF VM EDULIFE PLATFORM FOR ALL
STUDENTS AND FACULTIES TO ENHANCE LEARNING PROCESS BY USING ALL
VARIOUS MODULES DEVELOPED BY vmedulife.

OBJECTIVE

The objective of this MOU is fo express the willingness of both parties to engage to promote
e Competitiveness of VMEDULIFE Private Limited as well as its activities to develop and
cxpand relationships with Rajmata Jijau Shikshan Prasarak Mandal’s College of Pharmacy,
Pome

vmedulife Povate Limited agrees to provide technical assistance to assist Rajmata Jijau
Shikshan Prasarak Mandal’s College of Pharmacy, Pune for overall development of Students
and Saculiies to make them competent.

Rzmams J5an Shikshan Prasarak Mandal’s College of Pharmacy, Pune agrees to work with
aoC coordimate with VMEDULIFE Private Limited in development of their initiatives to
mmpsove and expand support to the corporate interactions too for the student’s overall
morovement. They also agree to allow vmedulife to carry out monitoring and evaluation
actrvities to assess the impact of these activities on participating.

~
o}

o= VMEDULIFE Pt Lid, S No.228, Office No. 404, Sanskruti Arcade, Wakad, 411057
2 Sales:=S156233 64758/ Support 1 +91 83007 033 52 info@vmedulifecom & waanavrned: i ~



An IS0 90012015 Certified Cormnpany.

Recognized by Govt. of Andhra Pradesh under Innovation ar
Startup Policy.

Recogmzed by DIPP, Ministzy of Commerce & industry,
Government of India.

An Official Industry Associate of SCCJ, Government of India.
Official Member of NASSCOM.
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Softwere Services
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PARTNER ORGANIZATIONS
The Memorandum of Understanding is between:

i. vmedulife Private Limited

2. Rajmata Jjjau Shikshan Prasarak Mandal’s College of Pharmacy, Pune

ROLES AND RESPONSIBILITIES
The Partmership/Advisory group is accountable for:

. ® Removing obstacles to the partnership’s successful delivery, adoption, and use

® Always maintaining the focus of the partnership on the agreed scope, outcomes and
benefiis
s Montioring and managing the factors outside the partnership’s control that are critical
0 HS SUCCEss.
The membership of the partnership/advisory group will commit to:
Artending all scheduled partnership group/advisory group meetings/conference
(Champion the partnership within and outside of work areas
Share all communications and information across all partnership/advisory group
Make timely decisions and act to not hold up the implementation.
s Notifving members of the Partnership Group/Advisory Group, as soon as practical, if

any matter arises which may be deemed to affect the development of the partnership.

® Auntendance at all meetings and if necessary, nominate a proxy.

Members of the advisory group expect:

. e That each member will be provided with complete, accurate and meaningful
information in a timely manner.
® To be given reasonable time to make key decisions.
e To be alerted to potential risks and issues that could impact the implementation, as
e Open and honest discussions

; VMEDULIFE Pvt. Lid, S No.228, Office No. 404, Senskruti Arcade, Wakad, 411057
* Sales: =351 96232 54758 / Support : +91 83807 01133 &2 info@vmeduiifecom 8 wwwmedulife
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A A A SRt

COMMUNICATION, INFORMATION SHARING AND CONSULTATION
PROCESSES

s Tmmely communication befween Institute Coordinator and vmedulife Executive for
Emplementation

¢ Iosunze coordipator must cooperate vmedulife Executive for all the required
mformation.

s wmedulife Executive always extend cooperation for successful implementation of all
the planned & modemized activities for institute.

CONFLICT RESOLUTION

a8 In case of any conflicts, both vmedulife Team and Institute concern authorities must discuss
anc come with solution without affecting student’s routine academics and ongoing activities
through vmedulife.

RESOURCES

The Instvimie needs to extend all the suppoit for satisfactory implementation of all the
modales and allow use the existing facilities for the activities related to Institute only.

PERIOD OF VALIDITY

Thes sereement shall be initially valid for 5 years from the date of signing the agreement and
0 be renewed subsequently by mutual consent of both the parties.

ARBITRATION

The parues to the Agreement shall settle any dispute arising regarding any aspect of this
A greement through mutual consultations and agreements.

. AUTHORISATION

The ssgming of this MOU is not a formal undertaking. It implies that the signatories will strive
1o reach the objectives stated in the MOU, to the best of their ability.
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An 150 90012015 Certified Company.

]
. il B ; Recognized by Govt. of Andhra Pradesh under Innovation a
V ' ' ‘ e ’ u l e } Stariup Policy.
: H Recognized by DIPP, Ministry of Commerce & industry,
Soffware Services § Government of India.
i

An Official Industry Associate of SCGI, Covernment of India.
Official Member of NASSCOM.

Partmering Organization:

Name: Rajmata Jijau Shikshan Prasarak Mandal’s Coliege of Pharmacy, Pune

SiverTm
PRI -

. Raimaiz Jau Shikshan Prasarak Mandal's

COLLEGE OF PHARMACY
Dudulozon, Puna-412 105,

Partmering Organization:
Name: VMEDULIFE PRIVATE LIMITED, PUNE
D 27 July 20Z l

aamaia Jyal Sh

Abbijeet Yeole,
Executive,

VMEDULIFE PRIVATE LIMITED
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. RAJMATA JIJAU SHIKSHAN PRASARAK MANDAL'S I

COLLEGE OF PHARMACY (B.Pharm.) i

Approved by PCI, AICTE, Govt.of Maharashtra & DTE

Affiliated to Savitribai Phule Pune University, Pune
DTE Code:- 6382

T SRISPM ==

RJ
Sﬂhs
anna

University Code:- CPHPO13150

Cammtted fov Encetipuce in Eduontinn
Certified by ISO 9001-2015,

Recognised as Green Educational
ISO : 14001-2015

Campus
Hon.Shri. Vilasrao V. Lande Hon.Shri. Sudhir V. Mungase Hon.Shri. Ajit D. Gavhane Dr. Kishor S. Jain
President Secretary Treasurer Principal
5.1) Invoices & Bills
Tl s g vane dea, Shics 31t Wit
Gat No.101/102, Moshi-Alandi Road, Dudulgaon, Pune. 2 ;
Post--Alandi, Tal.: Haveli, Pune-412105, Maharashtra (India) Commiitted for Excellence in Education
Phone : (020) 20280280, 7447763086, 9422322070

@ : www.rjspmpharmacy.com

Q@ O ® ra © /rispmpharmacy

Email: rjspmcop123@gmail.com



Proforma Tax Invoice

DELNET-Developing Library Network Invoice No
JNU Campus,Nelson Mandela Road,Vasant Kunj 20237 60428

Date
25-May-2023

New Delhi-110070

M hip No.
GSTIN/UIN: 07AAAAD2288G1ZV embership No

IM-7000

Mode Of Payment
DD/Multicity-Cheque/NEFT

Email: sangskaul2003@yahoo.co.in
Ph.No.+91-11-26742222,26741232 Reference No:
Fax. +91-11-26741122

R. J. S. P. M’s College of Pharmacy

Dudulgaon
Pune
Pin: 412105
Maharashtra
GSTIN/UIN:
S. No Particulars GST RATE Amount ¢
1 Annual Institutional Membership Fees (for the period 12.07.2023 to 11.07.2024) 18% 11,500.00
IGST 2070.00
Scan & Pay DELNET Bank Details

A/C Holder Name: DELNET

Bank Name: Central Bank Of India

Branch:Khan Market,New Delhi-110003

Alc No:- 1065410992 (Saving Account)

IFSC CODE: CBIN0280310

Total. 3 13,570.00
Amount Chargeable (in words)
{ THIRTEEN THOUSAND FIVE HUNDRED SEVENTY ONLY E &OE
Taxable Value Integrated Tax
SAC CODE:- 998431 Rate Amount
11500.00 18% 2070.00
Tax Amount (in words) ? TWO THOUSAND SFVENTY ONIY
PRINCIPAL
*ajmata Jijau Shikshan Prasarak Mandal's
COLLEGE OF PHARMACY

Dudulgaon, Pune-412 105.

For Bank Transfer

Kindly remit the amount through NEFT/RTGS only.DO NOT DEPOSIT THE CASH DIRECTLY TO DELNET BANK A/C.

Remarks:

DELNET's PAN AAAAD2288G

for DELNET- Developing Library Network

Authorised Signatory.

DD/CHEQUE SHOULD BE IN FAVOUR OF "DELNET". The DD should be made payable at "New Delhi" bank branch.

"This is a Computer generated Invoice - The signatures are not required."




No.: Receipt No./75801/2023-24 Dated 12-Jul-23

Received with thanks from :

The sum of
By

Remarks

%% 13,570.00/-

**Subject to Realisation

DELNET- Developing Library Network
Jawaharlal Nehru University Campus
Nelson Mandela Road, Vasant Kunj
New Delhi-110070
State Name : Delhi, Code : 07

Receipt

RJSPM'S COLLEGE OF PHARMACY
DUDULGAON, PUNE-412105
[DELNET MEM NO. IM-7000]

. Indian Rupees Thirteen Thousand Five Hundred Seventy Only

+ RJSPM'S COLLEGE OF PHARMACY:; The Cosmos Co-Operative Bank Ltd (ndia)

Inter Bank Transfer 000020142354 12-Jul-23 13,570.00

: AMOUNT RECEIVED TOWARDS ANNUAL INSTITUTIONAL MEMBERSHIP FEES

FOR THE PERIOD 12.07.2023 TO 11.07.2024

PRINCIPAL
*ajmata Jijau Shikshan Prasarak Mandal's

COLLEGE OF PHARMACY
Dudulgaon, Pune-412 105.




Proforma Tax Invoice

DELNET-Developing Library Network

JNU Campus,Nelson Mandela Road,Vasant Kunj
New Delhi-110070

GSTIN/UIN: 07AAAAD2288G1ZV

Email: sangskaul2003@yahoo.co.in
Ph.No.+91-11-26742222,26741232

Fax. +91-11-26741122

Membership No.
IM-7000

Invoice No Date
20227 53101 26-May-2022
Mode Of Payment

DD/Multicity-Cheque/NEFT

Reference No:

R. J. S. P. M’s College of Pharmacy

Dudulgaon
Pune
Pin: 412105
Maharashtra
GSTIN/UIN:
S. No Particulars GST RATE Amount ¥
1 Annual Institutional Membership Fees (for the period 12.07.2022 to 11.07.2023) 18% 11,500.00
IGST 2,070.00
Scan & Pay DELNET Bank Details

A/C Holder Name: DELNET

Bank Name: Central Bank Of India

Branch:Khan Market,New Delhi-110003

Alc No:- 1065410992 (Saving Account)

IFSC CODE: CBIN0280310

Total. 3  13,570.00
Amount Chargeable (in words)
% THIRTEEN THOUSAND FIVE HUNDRED SEVENTY ONLY E.&4OE
Taxable Value Integrated Tax
SAC CODE:- 998431 Rate Amount
11,500.00 18% 2,070.00
Tax Amount (in words) J TWO THOUSAND SEVENTY ONLY
PRINCIPAL
’ajmata Jijau Shikshan Prasarak Mandal's
COLLEGE OF PHARMACY

Dudulgaon, Pune-412 105.

For Bank Transfer

Kindly remit the amount through NEFT/RTGS only.DO NOT DEPOSIT THE CASH DIRECTLY TO DELNET BANK A/C.

Remarks:

DELNET's PAN AAAAD2288G

for DELNET- Developing Library Network

Authorised Signatory.

DD/CHEQUE SHOULD BE IN FAVOUR OF "DELNET". The DD should be made payable at "New Delhi" bank branch.

"This is a Computer generated Invoice - The signatures are not required."




NO.. Receipt No./70442/2022-23 Dated 30-Jun-22

. DELNET- Developing Library Network .
Jawaharlal Nehru University Campus
Nelson Mandela Road, Vasant Kunj
New Delhi-110070
State Name : Delhi, Code : 07

Receipt

Received with thanks from : RJSPM'S COLLEGE OF PHARMACY
DUDULGAON, PUNE-412105
[DELNET MEM NO. IM-7000]

The sum of  Indian Rupees Thirteen Thousand Five Hundred Seventy Only
By - RJSPM'S COLLEGE OF PHARMACY

Inter Bank Transfer 000021222588 29-Jun-22 13,570.00
Remarks : AMOUNT RECEIVED TOWARDS ANNUAL INSTITUTIONAL MEMBERSHIP FEES

FOR THE PERIOD 12.07.2022 TO 11.07.2023

PRINCIPAL

**¥13,570.00/- ‘ajmata Jijau Shikshan Prasarak Mandal's
LR N COLLEGE OF PHARMACY
Dudulgaon, Pune-412 10S.

**Subject to Realisation



. SNo. | Pharmacy

| 1. /Acta Pharmaceutica

| 2. Acta Pharmaceutica Sinica B

| 3. Adolescent Health, Medicine and Therapeutics

| 4, /Advanced Health Care Technologies

| 5. Advances in Pharmacoeidemiology

| 6. /Advances in Pharmacoepidemiology and Drug Safety
| 7. Advances in Pharmacological Sciences

\ 8. lAfrican Journal of Emergency Medicine

| 9. African Journal of Pharmacy and Pharmacology

\ 10. IAfrican Journal of Traditional Complementary and Alternative Medicine
| 11. Alcoholism and Drug Addiction

| 12. Alexandria Journal of Medicine

.13 Alimentary Pharmacology & Therapeutics

14 Alternative & Integrative Medicine

| 15. /American Journal of Pharmaceutical Education

- 16 Annals of Medicine & Surgery

17 Archives of Medicine

T Archives of Pharmacy Practice

\ 19. lAsian Journal of Pharmaceutical and Clinical Research
\ 20. lAsian Journal of Pharmaceutical and Health Sciences
\ 21. IAsian Journal of Pharmaceutical Sciences

| 22. Asian Journal of Pharmaceutics

\ 23. IAsian Pacific Journal of Tropical Medicine

| 24. Austin Journal of Pharmacology and Therapeutics
.25 B.M.C infectious Diseases

| 26. Biochemistry & Pharmacology Open Access

| 217. Blood and Lymphatic Cancer: Targets and Therapy

| 28. Brazilian Journal of Pharmaceutical Sciences

| 29. Breast Cancer: Targets and Therapy

\ 30. lBritish Journal of Pharmacology and Toxicology



https://www.degruyter.com/view/j/acph.2018.68.issue-1/issue-files/acph.2018.68.issue-1.xml
https://www.sciencedirect.com/journal/acta-pharmaceutica-sinica-b/issues
https://www.dovepress.com/adolescent-health-medicine-and-therapeutics-i1370-j89
https://www.dovepress.com/advanced-health-care-technologies-archive157
https://www.omicsonline.org/archive-advances-in-pharmacoepidemiology-drug-safety-open-access.php
https://www.omicsonline.org/archive-advances-in-pharmacoepidemiology-drug-safety-open-access.php
https://www.hindawi.com/journals/aps/contents/
https://www.sciencedirect.com/journal/african-journal-of-emergency-medicine/issues
http://www.academicjournals.org/journal/AJPP/archive
http://journals.sfu.ca/africanem/index.php/ajtcam/issue/archive
https://www.sciencedirect.com/journal/alcoholism-and-drug-addiction/issues
https://www.sciencedirect.com/journal/alexandria-journal-of-medicine/issues
https://onlinelibrary.wiley.com/loi/13652036
https://www.omicsonline.org/archive-alternative-integrative-medicine-open-access.php
http://www.ajpe.org/loi/ajpe
https://www.sciencedirect.com/journal/annals-of-medicine-and-surgery/issues
http://www.archivesofmedicine.com/archive.php
http://www.archivepp.com/backissues.asp
https://innovareacademics.in/journals/index.php/ajpcr/issue/archive
http://ajphs.com/archaview.php
https://www.sciencedirect.com/journal/asian-journal-of-pharmaceutical-sciences/issues
http://www.asiapharmaceutics.info/index.php/ajp/issue/archive
https://www.sciencedirect.com/journal/asian-pacific-journal-of-tropical-medicine/issues
http://austinpublishinggroup.com/pharmacology-therapeutics/archive.php
https://bmcinfectdis.biomedcentral.com/articles
https://www.omicsonline.org/archive-biochemistry-pharmacology-open-access.php
https://www.dovepress.com/blood-and-lymphatic-cancer-targets-and-therapy-i1440-j101
http://www.scielo.br/scielo.php?script=sci_issues&pid=1984-8250&lng=en&nrm=iso
https://www.dovepress.com/breast-cancer---targets-and-therapy-i1373-j69
http://maxwellsci.com/jp/BJPT.php?jid=BJPT

31.
32.
33.
34.
35.
36.
37.
38.
39.
40.
41.
42.
43.
44,
45.
46.
47.
48.
49.
50.
51.
52.
53.
54.
55.
56.
57.
58.
59.
60.
61.
62.
63.
64.
65.
66.

Bulletin of Faculty of Pharmacy, Cairo University
Cardiovascular Pharmacology

Chronic Diseases and Translational Medicine

Chronic Obstructive Pulmonary Disease: Journal of the COPD Foundation
Chronicles of Pharmaceutical Science

ChronoPhysiology and Therapy

Clinical Pharmacology: Advances and Applications
ClinicoEconomics

Current issues on Pharmacy and Medical Scinces

DARU : Journal of Pharmaceutical Sciences

Der Pharma Chemica

Der Pharmacia Lettre

Der Pharmacia Sinica

Diabetes, Metabolic Syndrome and Obesity: Targets and Therapy
Diagnostic and Therapeutics Endoscopy

Drug:Real world outcomes

Drug Design, Development and Therapy

Drug Designing

Drug Development and Therapeutics

Drug, Healthcare and Patient Safety

EBiomedicine

Egyptian Pharmaceutical Journal

Emergency Medicine

European Journal of Biomedical and Pharmaceutical Sciences

European Journal of Case reports in internal medicine

European Pharmaceutical Journal

European Respiratory Journal

Future Journal of Pharmaceutical Sciences

Gastrointestinal Cancer: Targets and Therapy

General Medicine

Global Journal of Pharmacy & Pharmaceutical Science

Hepatic Medicine : Evidence and Research

Herbal Medicine

HIV/AIDS-Research and Palliative Care

Immunity, Inflammation and Disease

Immunome Research



https://www.sciencedirect.com/journal/bulletin-of-faculty-of-pharmacy-cairo-university/issues
https://www.omicsonline.org/archive-cardiovascular-pharmacology-open-access.php
https://www.sciencedirect.com/journal/chronic-diseases-and-translational-medicine/issues
https://journal.copdfoundation.org/all-issues/past-issues
https://www.scientiaricerca.com/cops-archive.php
https://www.dovepress.com/chronophysiology-and-therapy-i1356-j107
https://www.dovepress.com/clinical-pharmacology-advances-and-applications-i1379-j65
https://www.dovepress.com/clinicoeconomics-and-outcomes-research-i1382-j29
https://www.degruyter.com/view/j/cipms.2017.30.issue-3/issue-files/cipms.2017.30.issue-3.xml
https://darujps.biomedcentral.com/articles
http://www.derpharmachemica.com/archive.html
http://www.scholarsresearchlibrary.com/journals/der-pharmacia-lettre/archive/
http://www.imedpub.com/der-pharmacia-sinica/archive.php
https://www.dovepress.com/diabetes-metabolic-syndrome-and-obesity-targets-and-therapy-i1385-j32
https://www.hindawi.com/journals/dte/contents/
https://link.springer.com/journal/volumesAndIssues/40801
https://www.dovepress.com/drug-design-development-and-therapy-i1386-j19
https://www.omicsonline.org/archive-drug-designing-open-access.php
http://www.ddtjournal.org/backissues.asp
https://www.dovepress.com/drug-healthcare-and-patient-safety-i1447-j44
https://www.sciencedirect.com/journal/ebiomedicine/issues
http://www.epj.eg.net/backissues.asp
https://www.omicsonline.org/archive-emergency-medicine-open-access.php
http://www.ejbps.com/ejbps/archive
https://www.ejcrim.com/index.php/EJCRIM/issue/archive
https://www.degruyter.com/view/j/afpuc.2017.64.issue-2/issue-files/afpuc.2017.64.issue-2.xml
http://erj.ersjournals.com/content/by/year
https://www.sciencedirect.com/journal/future-journal-of-pharmaceutical-sciences/issues
https://www.dovepress.com/gastro-intestinal-cancer-targets-and-therapy-i1388-j102
https://www.omicsonline.org/archive-general-medicine-open-access.php
https://juniperpublishers.com/gjpps/archive.php
https://www.dovepress.com/hepatic-medicine-evidence-and-research-i1389-j61
http://herbal-medicine.imedpub.com/archive.php
https://www.dovepress.com/hivaids---research-and-palliative-care-i1438-j68
https://onlinelibrary.wiley.com/loi/20504527/year/2018
https://www.omicsonline.org/archive-immunome-research-open-access.php

67. ImmunoTargets and Therapy

68. Indian Journal of Neonatal Medicine and Research

69. Indian Journal of Pharmaceutical Sciences

70. Indian Journal of Pharmacology

71. Indian Journal of Pharmacy Practice

72. Indian Journal of Research in Homeopathy

73. Indo Global Journal of Pharmaceutical Sciences

74. Infection and Drug Resistance

75. Innovations in Pharmacy

76. Infectious Diseases and Therapy

77. Integrated Pharmacy Research and Practice

78. Integrative Medicine Research

79. Internal Journal of Clinical Pharmacy

80. Internal Medicine

81. International Journal of Pharmaceutical and Phytopharmacological Research
82. International Journal of Applied Research in Natural Products
83. International Journal of Basic & Clinical Pharmacology

84. International Journal of Chemical and Pharmaceutical Sciences
85. International Journal of Drug Development & Research

86. International Journal of Drug Discovery

87. International Journal of Green Pharmacy

88. International Journal of Pharma Sciences and Research

89. International Journal of Pharmacological Research

90. International Journal of Pharmaceutical Investigation

91. International Journal of Pharmaceutical Sciences & Research
92. International Journal of Pharmaceutical Sciences : Review and Research
93. International Journal of Pharmacology and Clinical Sciences
94. International Journal of Pharmacy and Biological Sciences

95. International Journal of Pharmacy and Integrated Life Sciences
96. International Journal of Pharmacy and Pharmaceutical Sciences
97. International Journal of Pharmacy and Technology

98. International Journal of Physical Medicine & Rehabilitation
99. International Journal of Research in Ayurveda and Pharmacy
100. International Journal on General Medicine

101. International Research Journal of Pharmacy
102. Iranian Journal of Pharmaceutical Research



https://www.dovepress.com/immunotargets-and-therapy-i1391-j138
http://www.ijnmr.net/article_archive.asp
http://www.ijpsonline.com/archive.html
http://www.ijp-online.com/backissues.asp
http://ijopp.org/content/past-issues
http://www.ijrh.org/backissues.asp
http://www.iglobaljournal.com/igjps-2017-vol-7-issue-1/
https://www.dovepress.com/infection-and-drug-resistance-i1392-j28
https://pubs.lib.umn.edu/index.php/innovations/issue/archive
https://link.springer.com/journal/volumesAndIssues/40121
https://www.dovepress.com/integrated-pharmacy-research-and-practice-i1274-j135
http://www.imr-journal.com/issues
https://link.springer.com/journal/volumesAndIssues/11096
https://www.omicsonline.org/archive-internal-medicine-open-access.php
https://www.eijppr.com/archives.html
http://www.ijarnp.org/index.php/ijarnp/issue/archive
http://www.ijbcp.com/index.php/ijbcp/issue/archive
http://www.ijcps.com/sub_pages/archive.html
http://www.ijddr.in/archive.php
https://www.bioinfopublication.org/jouarchive.php?opt=&jouid=BPJ0000224
http://greenpharmacy.info/index.php/ijgp/issue/archive
http://www.ijpsr.info/all-issues.php
http://ssjournals.com/index.php/ijpr/issue/archive
http://www.jpionline.org/backissues.asp
http://ijpsr.com/archives-2/
http://www.globalresearchonline.net/clientnav/journalcontents.aspx
http://www.ijpcs.net/content/past-issues
http://www.ijpbs.com/archives.php
http://www.ijopils.com/volume-6
http://www.ijppsjournal.com/contents.htm
http://www.ijptonline.com/archives/
https://www.omicsonline.org/archive-physical-medicine-rehabilitation-open-access.php
http://www.ijrap.net/archives.php
https://www.dovepress.com/international-journal-of-general-medicine-i1395-j39
http://www.irjponline.com/archives.php
http://ijpr.sbmu.ac.ir/browse?_action=issue

103.
104.
105.
106.
107.
108.
109.
110.
111.
112.
113.
114.
115.
116.
117.
118.
119.
120.
121.
122.
123.
124.
125.
126.
127.
128.
129.
130.
131.
132.
133.
134.
135.
136.
137.
138.

Journal of Advanced Pharmaceutical Research

Journal of AIDS and HIV Infections

Journal of Anaesthesiology Clinical Pharmacology

Journal of Anesthesia and Patient Care

Journal of Applied Pharmaceutical Science

Journal of Advanced Pharmaceutical Research

Journal of Asthma and Allergy

Journal of Basic & Clinical Pharmacy

Journal of Blood Disorders & Transfusion

Journal of Blood Medicine

Journal of Cancer Research in Therapeutics

Journal of Cancer Science & Therapy

Journal of Cancer Science and Clinical Oncology

Journal of Cancer Therapeutics & Research

Journal of Carcinogenesis & Mutagenesis

Journal of Dentistry and Oral Care Medicine

Journal of Developing Drugs

Journal of Drug Delivery

Journal of Drug Metabolism & Toxicology

Journal of Ethnopharmacology

Journal of Experimental Pharmacology

Journal of Food and Drug Analysis

ournal of Forensic Medicine

Journal of Healthcare Leadership

Journal of Immunology & Infectious Disease

Journal of Korean Society for Clinical Pharmacology and Therapeutics
Journal of Neurodegenerative Diseases

Journal of Nuclear Medicine & Radiation Therapy

Journal of Nutrition and Health Sciences
Journal of Obesity and Overweight
Journal of Oncology Medicine & Practice
Journal of Ophthalmology

Journal of Pain Management & Medicine
Journal of Pharma Research

Journal of Pharmaceutical Analysis
Journal of Pharmaceutical Care



http://www.japtr.org/backissues.asp
http://www.annexpublishers.com/journals/journal-of-aids-and-hiv-infections/archive.php
http://www.joacp.org/backissues.asp
http://www.annexpublishers.com/journals/journal-of-anesthesia-and-patient-care/archive.php
http://japsonline.com/past-issue.php
http://www.japtr.org/backissues.asp
https://www.dovepress.com/journal-of-asthma-and-allergy-i1399-j27
https://www.jbclinpharm.org/archive.html
https://www.omicsonline.org/archive-blood-disorders-transfusion-open-access.php
https://www.dovepress.com/journal-of-blood-medicine-archive85
http://www.cancerjournal.net/backissues.asp
https://www.omicsonline.org/archive-cancer-science-therapy-open-access.php
http://www.annexpublishers.com/journals/journal-of-cancer-science/archive.php
http://www.hoajonline.com/jctr/articles
https://www.omicsonline.org/archive-carcinogenesis-mutagenesis-open-access.php
http://annexpublishers.com/journals/journal-of-dentistry-and-oral-care/archive.php
https://www.omicsonline.org/archive-developing-drugs-open-access.php
https://www.hindawi.com/journals/jdd/contents/
https://www.omicsonline.org/archive-drug-metabolism-toxicology-open-access.php
https://www.sciencedirect.com/journal/journal-of-ethnopharmacology/issues
https://www.dovepress.com/journal-of-experimental-pharmacology-i1448-j66
https://www.sciencedirect.com/journal/journal-of-food-and-drug-analysis/issues
https://www.omicsonline.org/archive-journal-forensic-medicine.php
https://www.dovepress.com/journal-of-healthcare-leadership-i1401-j91
http://www.annexpublishers.com/journals/journal-of-immunology-and-infectious-diseases/archive.php
https://koreamed.org/JournalVolume.php?id=1179
https://www.hindawi.com/journals/jnd/contents/all/
https://www.omicsonline.org/archive-nuclear-medicine-radiation-therapy-open-access.php
http://www.annexpublishers.com/journals/journal-of-nutrition-and-health/archive.php
http://www.annexpublishers.com/journals/journal-of-obesity-and-overweight/archive.php
https://www.omicsonline.org/archive-oncology-medicine-practice.php
https://www.hindawi.com/journals/joph/contents/
https://www.omicsonline.org/archive-pain-management-medicine.php
http://jprinfo.com/Archives.php
http://www.sciencedirect.com/science/journal/20951779
http://jpc.tums.ac.ir/index.php/jpc/issue/archive
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161.
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165.
166.
167.
168.
169.
170.
171.
172.
173.
174.

Journal of Pharmaceutical Care & Health Systems

Journal of Pharmaceutical Negative Results

Journal of Pharmaceutical Science and Bio scientific Research
Journal of Pharmaceutics and Drug Development

Journal of Pharmacognosy & Natural Products

Journal of Pharmacological Sciences

Journal of Pharmacology & Clinical Toxicology

Journal of Pharmacology & Pharmacotherapeutics

Journal of Pharmacovigilance

Journal of Pharmacy and Bioallied Sciences

Journal of Pharmacy and Pharmaceutical Sciences

Journal of Pharmacy Practice and Community Medicine
Journal of Pharmacy Teaching

Journal of Preventive Medicine

Journal of Pulmonary & Respiratory Medicine

Journal of Research in Pharmacy Practice

Journal of Sports Medicine & Doping Studies

Journal of Surgery and Operative Care

Journal of Tropical Diseases & Public Health

Journal of Vascular Medicine & Surgery

Journal of Vector Borne Diseases

Journal of Young Pharmacists

Marine Drugs

Metal-Based Drugs

National Journal of Physiology, Pharmacy and Pharmacology
Occupational Medicine & Health Affairs

Drug Delivery Journal

Orphan Drugs: Research and Reviews

Pediatric Health, Medicine and Therapeutics

Pharmaceuticals

Pharmaceutics

Pharmacie Globale : International Journal of Comprehensive Pharmacy
Pharmacogenomics and Personalized Medicine
Pharmacology & Therapeutics
Pharmacology and Pharmacy
Pharmacy Practice



https://www.omicsgroup.org/journals/archive-pharmaceutical-care-and-health-systems-open-access.php
http://www.pnrjournal.com/backissues.asp
http://jpsbr.org/JPSBR.htm
http://www.annexpublishers.com/journals/journal-of-pharmaceutics-and-drugs-development/archive.php
https://www.omicsonline.org/archive-pharmacognosy-natural-products.php
https://www.sciencedirect.com/journal/journal-of-pharmacological-sciences/issues
https://www.jscimedcentral.com/Pharmacology/allissues.php
http://www.jpharmacol.com/backissues.asp
https://www.omicsonline.org/archive-pharmacovigilance-open-access.php
http://www.jpbsonline.org/backissues.asp
https://ejournals.library.ualberta.ca/index.php/JPPS/issue/archive
http://www.jppcm.org/content/archives
https://www.clockss.org/clockss/Journal_of_Pharmacy_Teaching
http://preventive-medicine.imedpub.com/archive.php
https://www.omicsonline.org/archive-pulmonary-respiratory-medicine-open-access.php
http://www.jrpp.net/backissues.asp
https://www.omicsonline.org/archive-sports-medicine-doping-studies-open-access.php
http://www.annexpublishers.com/journals/journal-of-surgery-and-operative-care/archive.php
https://www.esciencecentral.org/journals/archive-tropical-diseases-open-access.php
https://www.omicsonline.org/archive-vascular-medicine-surgery-open-access.php
http://www.nimr.org.in/jvbd.html
http://www.jyoungpharm.org/content/past-issues
http://www.mdpi.com/journal/marinedrugs
http://www.ncbi.nlm.nih.gov/pmc/journals/493/
http://www.njppp.com/?sec=archive
https://www.omicsonline.org/archive-occupational-medicine-health-affairs-open-access.php
http://benthamopen.com/TODDJ/VOLUME/5/
https://www.dovepress.com/orphan-drugs-research-and-reviews-archive136
https://www.dovepress.com/pediatric-health-medicine-and-therapeutics-archive103
http://www.mdpi.com/journal/pharmaceuticals
http://www.mdpi.com/journal/pharmaceutics
http://pharmacie-globale.info/index.php?option=com_docman&Itemid=41
http://www.dovepress.com/pharmacogenomics-and-personalized-medicine-archive38
http://www.sciencedirect.com/science/journal/01637258/open-access
http://www.scirp.org/Journal/Home.aspx?IssueID=10679
http://www.pharmacypractice.org/journal/index.php/pp/issue/archive

. 175.  |Pharmacy-MDPI

\ 176. IResearch & Reviews: Journal of Hospital and Clinical Pharmacy
| 177. Research Journal of Pharmacognosy

| 178. Robotic Surgery: Research and Reviews

\ 179. ISOJ Microbiology & Infectious Diseases

| 180. Southern Med Review

\ 181. IStamford Journal of Pharmaceutical Sciences

| 182. The Open Biomarkers Journal (Bentham)

| 183. The Open Biotechnology Journal (Bentham)

| 184. The Open Infectious Diseases Journal

| 185.  |The Open Medicinal Chemistry Journal (Bentham)

\ 186. IThe Open Nanoscience Journal (Bentham)

. 187.  The Open Natural Products Journal (Bentham)

\ 188. IThe Open Nitric Oxide Journal (Bentham)

\ 189. IThe Open Nutraceuticals Journal (Bentham)

\ 190. IThe Open Pain Journal (Bentham)

\ 191. IThe Open Pharmacoeconomics & Health Economics Journal (Bentham)
\ 192. IThe Open proteomics journal (Bentham)

\ 193. IToxicoquv Journal

. 194.  Therapeutics and Clinical Risk Management

195 |Toxicology

\ 196. ITransIationaI Biomedicine

. 197.  [Tropical Journal of Pharmaceutical Research

| 198.  |Universal Journal of Pharmacy

\ 199. IVeterinarv Medicine: Research and Reviews

| 200. World Journal of Gastrointestinal Pharmacology and Therapeutics

0 DELNET-Developing Library Network. All Rights Reserved. DELNET uploads data received from its member-libraries in the form of union catalogues, union-lists and othe
t responsible for the confidentiality and accuracy of data so presented on this site. Also, DELNET is not responsbile for the contents of any Linked Site listed above.

PRINCIPAL
'ajmata Jijau Shikshan Prasarak Mandal's

COLLEGE OF PHARMACY
Dudulgaon, Pune-412 106.



http://www.mdpi.com/search?q=&journal=pharmaceutics&sort=pubdate&page_count=50
http://www.rroij.com/archive-hospital-and-clinical-pharmacy.php
http://rjpharmacognosy.ir/browse?_action=issue
https://www.dovepress.com/robotic-surgery-research-and-reviews-i1444-j154
https://symbiosisonlinepublishing.com/microbiology-infectiousdiseases/archive.php
http://www.ncbi.nlm.nih.gov/pmc/journals/1901/
http://banglajol.info/index.php/SJPS/issue/archive
https://www.benthamopen.com/TOBIOMJ/VOLUME/8/
https://www.benthamopen.com/TOBIOTJ/VOLUME/12/
https://benthamopen.com/TOIDJ/VOLUME/10/
https://www.benthamopen.com/TOMCJ/VOLUME/12/
http://www.benthamopen.com/TONANOJ/VOLUME/8/
https://www.benthamopen.com/TONPJ/VOLUME/8/
http://www.benthamopen.com/TONOJ/VOLUME/4/
http://www.benthamopen.com/TONUTRAJ/VOLUME/8/
http://www.benthamopen.com/TOPAINJ/VOLUME/8/
http://www.benthamopen.com/TOPHARMEJ/VOLUME/5/
http://www.benthamopen.com/TOPROTJ/VOLUME/7/
https://benthamopen.com/TOTOXIJ/home/
https://www.dovepress.com/therapeutics-and-clinical-risk-management-i1432-j1
https://www.omicsonline.org/archive-toxicology.php
http://www.transbiomedicine.com/archive.php
https://www.tjpr.org/home/issues.php?issue=current
http://ujponline.com/ujp/past-issues/
https://www.dovepress.com/veterinary-medicine-research-and-reports-i1434-j108
http://www.wjgnet.com/2150-5349/archive.htm
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5.2) Invoices & Bills
Ex-Pharm Software
Tl s g vane dea, Shics 31t Wit
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Bureau for Health and Education Status Upliftment
(Constitutionaly Entitled as Health-Education, Bureau)

55/20, Rajat Path, Mansarovar, Jaipur

Rajasthan, Pin : 302020

Contact : Basic : 0141-2783681, Mob. : 8690723563

Mail : support@heb-nic.in, serviceheb@gmail.com

Website : www.heb-nic.in

: Date:27/02/2020
Ref. No: HEB/EPS/2020/7149

To

The Principal,

RJSPM'S college of Pharmacy

Gat Neo. 101-102, Dudulgaon, Moshi-Alandi Road,
Pune, Maharashtra - 412105

Subject: Confirmation of subscription

Dear Sir,

In response to subscription request and subscription amount received from you, we are here by sending vou the
dedicated password of Experimental Pharmacology Series (Ex-Pharm Series) Software and the invoice (attached

with letter).

We hereby confirm your subscription of Experimental Pharmacology Series (Ex-Pharm Series) Software from
Feb-20 to Jan-23 (3 Years).

To view Experimental Pharmacology Series (Ex-Pharm Series) Software, please enter the password in below
mentioned link

Link: http://heb-nic.in/Ex-Pharm/login.php
User ID: rjspm
Password: rjspm123

You will be receiving further communications time to time also.

Thanking you
| Diéetor /-
Digital-Service Division
- “\\Ai—-’)ﬂ
0 : PRIN AL
E.Hcfl?ﬁzd[}mice ajmata Jijau Shikshan Prasarak Mandal's
: COLLEGE OF PHARMACY

% User Manual Dudulgaon, Pune-412 105.



B Sty AT 5N SN T

(Bringing Innovations in Health & Learning)
Address: 55/20, Rajat Path, Mansarovar,
Jaipur, Rajasthan, Pin:302020
Contact:0141-2783681, 9636348191

Mail: serviceheb@gmail.com, support@heb-nic.in

Website: www.heb-nic.in, www.journalofhospitalpharmacy.in

INVOICE

PAN NO: AGAPA7570)

GST Reg. No: 08AJAPA7570]1Z8

INVOICE NO: 5945/2020
DATE: 27/02/2020

The Principal, - FORM: PRODUCT CODE: | SUBPRODUCT |  BOOKING
RJSPM'S college of Pharmacy CODE: EXECUTIVE
Gat No. 101-102, Dudulgaon, Moshi-Alandi Road, Sl CODE:
Pune, Maharashtra - 412105 B
ONLINE MHMAK
CLIENT LOCATION: Pune
SR. SUBSCRIPTION
NO. DESCRIPTION AMOUNT GST GST NET PRICE CATEGORY
IN
RUPEES RATE
FROM T0 SGST CGST
Experimental
1 Pharmacology | FEB-20 JAN-23 25040 18% 2253.5 2253.5 29547 INSTITUTION
Series (Ex-
Pharm Series)
AMOUNT IN WORDS: Twenty Nine Thousand Five Hundred Forty Seven Rupees Only
PAYMENT RECEIVED BALANCE TO COLLECT
MODE AMOUNT | TRANS.NO. DATE BANK MODE AMOUNT | TRANS. NO. DATE BANK
CASH CASH
|

D.D./CHEQUE D.D./CHEQUE

NEFT/RTGS NEFT/RTGS

ANY OTHER 29547 - = 5 ANY OTHER
PAYMENT RECEIVED: Twenty Nine Thousand Five Hundred Forty BALANCE TO COLLECT:

‘Seven Rupees Only
FOR HEALTH EDUCATION BUREAU
PRINCIPAL
»ajmata Jijau Shikshan Prasarak Mandal's
COLLEGE OF PHARMACY

AUTHORISED SIGNATORY
DATE: 27/02/2020

Dudulgaon, Pune-412 105.




RAIMATA JUAU SHIKSHAN PRASARAK MANDAL's o /.a\

COLLEGE OF PHARMACY !

Approved by ATCTE & PCI New Dethi, DTE, Govt. of Maharashirs &
Affiliated to University of Pune
Gat No 1017102, A Post-Dudulgaon, Post-Alandi, Tal-Haveli, Dist-Pune - 412 105
E-mail: tispmcop] 2 3@gmail comWeb: www rjspmpharmacy com :
Univ 1d: PU/PN Pharm/286/2007  College Code: 1081 DTE Code:6382

P/ Cop/ 2002 - 28 14

A o

To,
RISPM’s College of Pharmacy, 2
Dudulgaon ~Pune.

Subject: Gentle reminder regarding *Renewal of Ex-Pharm software subscription”

Respected sir,
. With respect to above mentioned subject, we are using “Ex-Pharm software” for

conducting Pharmacology practicals for B pharmacy students as per PCI syllabus from last
three years. Our previous subscription for the Ex-Pharm software was from Feb- 2020 to
Jan- 2023 (Three years) and it is expiring in January 2023. (Enclosure-1).

This software subscription is mandatory as per PCl syllabus and it is one of the
eria 4 and criteria 7). For three years subscription

strongest point for NAAC. (Critefia 2,
of this software it costs around 29,547 RS. Kincluding GST). (Enclosure-2).

So, | request you to glt;ase tredt this urgent and permit for the process of renewal
of Ex-Pharm software as soon’as possible as this subscription is expiring on 31 January 2023.

PRINCIPAL
Rajmata Jijau Ehkshan Prasarak Manda"
COLLEGE OF PHARMACY
Dudulgaon, Pune-412 105.

Enclosure-1: Previous Ex-Pharm software subscription.
Enclosure-2: Subscription form with quotation.
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Bureaii for Healh and Education Status Upliftment
( ealth-Education, Bureay)
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To

The Principal,

RJSPM’S college of Pharmacy

Gat No. 101-1 02, Dudulgaon, Moshi-Alandi Road,
Pune, Maharashtra - 412105 '

Subject: Confirmation of subseription

Dear Sir,

In response to subscription teyuest and subscription amonnt received from you, we are here bﬂlﬁmh
dedicated password of Experimental Pharmacology Series (Ex-Pharm Series) Software and the invoice (attached

with letter).
We hereby confirm Your subscription of Experimental Pharmacology Series (Ex-Pharm Series) Software from
Feb-20 to Jan-23 (3 Years).

To view Experimental Pharmacology Series (Ex-Pharm Series) Software, please enter the password in below
mentioned link

Link: http://heb-nic.in/Ex-Phnu/login.php
User ID: rispm
Password: rjspm123

You will be receiving further communications time to time also,




it I e s Ay s

(6ringing Innovations in Health & Learning)
Jaipur, Rajasthan, Pin:302020
Contact:0141-2783681, 9636348191
Mail: serviceheb@gmail .com, Phe o
Wabsite: www.heb-nic.in, www.'omwm, -
PAN NO: AGAPA7570) GST Reg. No: 0BAJAPA7570/1Z8 mvonlce NO:5945/2020 |
= - .
The Principal, FORM: | PRODUCT CODE: | SUB T[ sooknG |
RISPM'S college of Pharmacy G CODE: EXECUTIVE |
1 GatNo. 10!-[02: Dudulgaon, Moshi-Alandi Road, A ; v oo
Pone, Maharashtra - 412105 ONLINE MHMAK 5
CLIENT LOCATION: Punie
SR. SUBSCRIPTION i G
NO. | DESCRIPTION AMOUNT GST GST NET PRICE CATEGORY
R IN < ,
» RATE f
Son | w» | W SGST | CGST
1. a : w SR - P
o 1 | Pharmacology | FEB-20 | JAN-23 | 25040 18% 22535 | 22535 29547 INSTITUTION
- Series (Ex- -
Pharm Series)
AMOUNT IN'WORDS: Twenty Nine Thousand Five Hundred Forty Seven Rupees Only
PAYMENT RECEIVED BALANCE TO COLLECT
MODE AMOUNT TRANS. NO. D'ATE BANK MODE AMOUNT | TRANS. NO. DATE BANK o
‘CASH CASH
D.D./CHEQUE D.D./CHEQUE
| erans NEFT/RTGS :
1 WYOTHER | 29547 - - . ANY OTHER 3
| PAYMENT RECBVED: Twenty Nine Thousand Five Handred Forty | BALANCE TO COLLECT:




Contact:0141-2783681, 9636348I19|1
_— T "Tmem Mail: servlceheb@gmdl com, support@heb-nic.in

STATUS UPLIFEMENT Website: www.heb-nic.in
(Constitutionally Entitled As- Health Education Bureau) A

Address: 55/20, Rajat Path, Mansarovar,

Jaipur, Rajasthan, Pin:302020

Date: 05/01/2023
i : 2301054/2023
i tation Proforma Invoice/Quotation No.:
Proforma Invoice/Quo ST e, oo GRAKA A IS
Category: Institution
Billing Address Office Address
RISPM'S college of Pharmacy RISPM'S college of Pharmacy d
Gat No. 101-102, Dudulgaon, Moshi-Alandi Road, Gat No. 101-102, Dudulgaon, Moshi-Alandi Road,
Pune, Maharashtra - 412105 Pune, Maharashtra - 412105
Quantity Description (Subscription) Duration Unit price GST Total
B Ex Pharm 3 Years 25,040 X 4,507 X 29,547 %
Experimental Pharmacolo
s Series Software ) (Comprehensive Pack)
All Demand Draft & Cheque should be in favor of “Health Education Bureau” Payable at Jaipur, Sub Total 29,547% g
Rajasthan Remarks : i
Final invoice will be issued at the completion of payment. Total Due 29,547 % :

Remit payment in INR to Following Account Details:

Account Name: Health Education Bureau,

Bank: UCO Bank

Branch: Mansarovar, Jalpur, Rajasthan

Account No.20960210003121,

IFSC Code: UCBA0002096 s

Address: 55/20, Rajat Path, Mansarovar, Jaipur, Rajasthan (India), PIN-302020
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5.3) Invoices & Bills
Words Worth Software
Tl s g vane dea, Shics 31t Wit
Gat No.101/102, Moshi-Alandi Road, Dudulgaon, Pune. . ;
Post--Alandi, Tal.: Haveli, Pune-412105, Maharashtra (India) Commiitted for Excellence in Education
Phone : (020) 20280280, 7447763086, 9422322070

‘% : www.rjspmpharmacy.com

Q@ O ® ra © /rispmpharmacy

Email: rjspmcop123@gmail.com



SILLED TO:
s SHIPFED TO:
RAJMATA JIJAU SHIKSHAN PRASARAK MANDAL'S RAJMATA J1JAU SHIKSHAN PRASARAK MANDAL’S COLLEGE OF PHARMACY SR :
COLLEGE OF PHARMACY GAT NO. 101/102 A, AT: DUDALGAON, POST: ALANDI, TALUKA: HAVELL, DIST.: PUNE, PN 3
GAT NO. 101/102 A, AT: DUDALGAON, MAHARASHTRA - 412105 ACTUNI»\( |
POST: ALANDI, TALUKA: HAVELI, DIST.: PUNE, TEL:  020-20280544, 9850601224 [MAHESH GIRME] \\ e :
MAHARASHTRA 412105 FAX: 94222979963 [MRS. SNEHA K. PATIL]
Academy For Computer
STATE CODE: 27 PLACE OF SUPPLY: MAHARASHTRA Training (Guj) Pvt. Ltd.
CUSTOMER REF: VIA EMAIL CURRENCY:
BILL No: 158/WW/AMC/22-23 DTD.: 15.06.2022 INDIAN RUPEES Tax Invoice
DATE: 8% OCT,, 2022 CUSTOMER GST NO.: NOT APPLICABLE ON EDUCATIONAL INSTITUTIONS DELIVERY: ONGOING
PAYMENT TERMS: IMMEDIATELY TS
Academy For
Computer Training {
(Guj) Pvt. Ltd. | SAC CODE &
I PRODUCT CODE QUANTITY DESCRIPTION UNIT PRICE VALUE
REGD. OFFICE:
202-203, Parth | | )
Empire. I 997331 FOR A PERIOD  Renewal, Up gradation and Annual Maintenance Charges for Words 25,000/- 25,000/~
pre, AMC OF ONE YEAR  Worth Senior English Language Lab License

Rambaug, Maninagar
Ahmedabad 380008

Tel:  +91-79-2546 4080
Fax:  +91-78-2546 4495

MARKETING OFFICE:
204, Silicon Towers,
Nr. Law Garden,

Off C.G. Road,
Ahmedabad 6
Gujarat, INDIA

Tel  +91-78-254558536

[PERIOD: 365 days from the date of renewal of software]

5 B T AT TS e B M o ot o o7 7

+91-79-2646 8538 PRIN AL
PAN NO: AABCA2973L St i ikshan Prasarak Mandal's
STATE CODE.: 24 ‘ajmata Jyou ol RMACY TOTAL 25,000/-
GST NO.: \JOLLEGE OF PHA IGST@ 18% 4,500/~
24AABCA2973L1284 Dudulgaon, Pune-412 105.
: TOTAL 29,500/~
Company Reg. No.: 4
U72200GJ1996PTC023920 Amount In Words: Rs. Twenty Nine Thousand Five Hundred Only
E-MAIL:
crm@wordsworthelt.com
Web Siter -
wv?w.actuniv.com NOTE:

ww.wordswortheltcom 227 o o 1. SUBJECT TO AHMEDABAD JURISDICTION / MEDIA TO BE PROVIDED BY Customer
"~ 2. PLEASE FAYOUR CHEQUE TO: Academy far Computer Training (Guj.) Pvt. Ltd.

3. PAYMENT DETAIL: Bank Name: ICICI Bank Limited, Branch: Ambawadi, 28,500=00

Ahmedabad, Account # 1655 0500 0012 IFSC Code: ICIC0001655

\\ \ /

Authorized Signatt
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5.4) Invoices & Bills
Tl s g vane dea, Shics 31t Wit
Gat No.101/102, Moshi-Alandi Road, Dudulgaon, Pune. 2 ;
Post--Alandi, Tal.: Haveli, Pune-412105, Maharashtra (India) Commiitted for Excellence in Education
Phone : (020) 20280280, 7447763086, 9422322070
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Tax Invoice

Original for Recipient and Duplicate for Supplier

InvoiceDate:  Mar 12,2023
Invoice#:  INV192772072
Payment Terms: Due Upon Receipt
DueDate: Mar 12,2023
Account Number: 5041946683
Currency: INR
Account Information: RJSPM's College of Pharmacy, Pune

Consignee (Placeofsupply):  RJSPM's College of Pharmacy, Pune
GatNo. 101-102, Dudulgaon, Moshi-Alandi Road,, ...
pune, Maharashtra412105 India

rispmsplacement@gmail.com
Name of Recipient (Billed to):  RJSPM's College of Pharmacy, Pune
GatNo. 101-102, Dudulgaon, Moshi-Alandi Road,, ...

pune, Maharashtra412105 India

rispmsplacement@gmail.com

200m

ZVCIndia Private Limited

Raheja Platinum, No.06A113A,06A127
Sag Baug Road, Marol, Andheri East
Mumbai, Maharashtra, 400059

Zoom GSTIN: 27AABCZ4218R1ZP
Zoom PAN: AABCZ4218R
Purchase Order Number:

Customer GSTIN:
Customer PAN:

Whether taxis payable on reverse charge basis - No.

Zoom W-9

Question about your Digital Signature?

PRINCIPAL
*ajmata Jijau Shikshan Prasarak Mandal's

COLLEGE OF PHARMACY

i Dudulgaon, Pune-412 105.
Charge Details .
TAXES, FEES &
CHARGE DESCRIPTION SUBSCRIPTION PERIOD SUBTOTAL TOTAL
SURCHARGES
Charge Name: Zoom OnePro
Monthly
Quantity: 1 Mar 12,2023 - Apr 11,2023 INR1,300.00 INR234.00 INR1,534.00
Unit Price: INR1,300.00
HSN of Goods/Services: 998424
Taxable Value INR1,300.00
Total (Including Taxes, Fees & Surcharges) INR1,534.00
Invoice Balance INRO.0O

Taxes, Fees & Surcharge Details


https://support.zoom.us/hc/en-us/articles/201080605-W-9-Wire-Transfer-Instructions
https://support.zoom.us/hc/en-us/articles/360057516312

TAX,FEEOR

CHARGE NAME SURCHARGE JURISDICTION CHARGE AMOUNT TAX, FEE OR SURCHARGE

AMOUNT
NAME
CGST
Zoom One Pro Monthly (Communications) Federal INR1,300.00 INR117.00
9.000%
SGST
Zoom One Pro Monthly (Communications) Federal INR1,300.00 INR117.00
9.000%
Total (Including Taxes, Fees & Surcharges) INR234.00
Transactions
Invoice Total INR1,534.00
TRANSACTION TRANSACTION
TRANSACTIONTYPE DESCRIPTION APPLIED AMOUNT
DATE NUMBER
Mar 12,2023 P-224492541 Payment INR-1,534.00
Mar 13,2023 R-02267884 Refund INR1,534.00
Mar 21, 2023 P-226278050 Payment INR-1,534.00
Mar 22,2023 R-02291317 Refund INR1,534.00
Mar 30, 2023 P-228084353 Payment INR-1,534.00
Mar 31, 2023 R-02313191 Refund INR1,534.00
Apr 8,2023 P-229828171 Payment INR-1,534.00
Apr 9,2023 R-02330211 Refund INR1,534.00
Apr 17,2023 P-231531733 Payment INR-1,534.00
Apr 18,2023 R-02348982 Refund INR1,534.00
May 25,2023 11A-10549821 Invoice ltem Automated Approved Write Off INR-1,300.00

Adjustment



Invoice ltem

May 25,2023 11A-10549822 . Automated Approved Write Off INR-117.00
Adjustment
Invoice Item .
May 25,2023 11A-10549825 . Automated Approved Write Off INR-117.00
Adjustment
Invoice Balance INRO.0O

Need help understanding your invoice? CLICK HERE

Standard Pro and Standard Biz are now called Zoom One Pro and Zoom One Business. Please note that your Services will remai...

This plan includes products with monthly and/or yearly subscription periods. The subscription period for each plan, a...

PRINCIPAL
*ajmata Jijau Shikshan Prasarak Mandal's

COLLEGE OF PHARMACY
Dudulgaon, Pune-412 105.



https://support.zoom.us/hc/en-us/articles/360057516312-Understanding-your-invoice-

Tax Invoice

Original for Recipient and Duplicate for Supplier

200Mm

Z\V/C India Private Limited

Raheja Platinum, No.06A113A,06A127
Sag Baug Road, Marol, Andheri East
Mumbai, Maharashtra 400059

Invoice Date:

Invoice #:

Payment Terms:

Due Date:

Account Number:
Currency:

Account Information:

Name of Consignee
(Place of supply):

Nov 1, 2022

INV173735246

Due Upon Receipt

Nov 1, 2022

5041946683

INR

RJSPM's College of Pharmacy, Pune

RJSPM's College of Pharmacy, Pune
Gat No. 101-102, Dudulgaon, Moshi-Alandi

Zoom GSTIN: 27AABCZ4218R1ZP
Zoom PAN: AABCZ4218R

Purchase Order Number:

Customer GSTIN:
Customer PAN:

Road,, Pune, Maharashtra 412105,
pune, Maharashtra 412105 (State Code: 27)
India

Whether tax is payable on reverse charge basis - No.
rispmsplacement@gmail.com

Name of Recipient
(Billed to):

RJSPM's College of Pharmacy, Pune

Gat No. 101-102, Dudulgaon, Moshi-Alandi
Road,, Pune, Maharashtra 412105,

pune, Maharashtra 412105 (State Code: 27)
India

Zoom W-9

Question about your Digital Signature?

rispmsplacement@gmail.com

Charge Details

TAXES, FEES &

CHARGE DESCRIPTION SUBSCRIPTION PERIOD SUBTOTAL SURCHARGES TOTAL
Charge Name: Zoom One Pro
Monthly
Quantity: 1
Unit Price: INR1,300.00 Nov 1, 2022-Nov 30, 2022 INR1,300.00 INR234.00 INR1,534.00
HSN of Goods/Services: HSN
998424
Taxable Value INR1,300.00
Total (Including Taxes, Fees & INR1,534.00
Surcharges)
Invoice Balance INR1,534.00
Taxes, Fees & Surcharge Details
PRIN AL
*ajmata Jijau Shikshan Prasarak Mandal's
COLLEGE OF PHARMACY

Dudulgaon, Pune-412 105.


https://support.zoom.us/hc/en-us/articles/201080605-W-9-Wire-Transfer-Instructions
https://support.zoom.us/hc/en-us/articles/360057516312

Invoice 200Mm

TAX, FEE OR
CHARGE SURCHARGE TAX, FEE OR SURCHARGE
NAME NAME JURISDICTION CHARGE AMOUNT AMOUNT
SGST
Zoom One Pro/Standard
Pro Monthl (Communications) Federal INR1,300.00 INR117.00
Y 9.000%
CGST
Zoom One Pro/Standard
(Communications) Federal INR1,300.00 INR117.00
Pro Monthly 9.000%

Total (Including Taxes, Fees & Surcharges) INR234.00

Need help understanding your invoice?

Standard Pro and Standard Biz are now called Zoom One Pro and Zoom One Business. Please note that your Services will remain the
same and that this name change does not change the price of your current subscription.

This plan includes products with monthly and/or yearly subscription periods. The subscription period for each plan,
and the total charge, INR1,300.00 (plus applicable taxes and regulatory fees), per subscription period for that
product are set out above in the Charge Details section. Unless you cancel, your subscription(s) will auto-renew each
subscription period and each subscription period thereafter, at the price(s) listed above (plus any taxes and regulatory
fees applicable at the time of renewal) and your payment method on file at zoom.us/billing will be charged. You can
cancel auto-renewal anytime, but you must cancel by the last day of your current subscription period to avoid being
charged for the next subscription period. You will not be able to cancel your "base plan" (Zoom Meetings, Zoom
Phone, or Zoom Rooms) without first canceling all other subscriptions in your plan. If you cancel, you will not receive
a refund for the remainder of your then-current subscription period. You can cancel by navigating to zoom.us/billing
and clicking "Cancel Subscription," clicking through the prompts, and then clicking to confirm cancellation. Should
Zoom change its pricing, it will provide you with notice, and you may be charged the new price for subsequent
subscription.

PRINCIPAL
*ajmata Jijau Shikshan Prasarak Mandal's

COLLEGE OF PHARMACY
Dudulgaon, Pune-412 108.



https://support.zoom.us/hc/en-us/articles/360057516312-Understanding-your-invoice-

Tax Invoice

Original for Recipient and Duplicate for Supplier

200Mm

Z\V/C India Private Limited

Raheja Platinum, No.06A113A,06A127
Sag Baug Road, Marol, Andheri East
Mumbai, Maharashtra 400059

Invoice Date:

Invoice #:

Payment Terms:

Due Date:

Account Number:
Currency:

Account Information:

Name of Consignee
(Place of supply):

Oct 1, 2022

INV169246440

Due Upon Receipt

Oct 1, 2022

5041946683

INR

RJSPM's College of Pharmacy, Pune

RJSPM's College of Pharmacy, Pune
Gat No. 101-102, Dudulgaon, Moshi-Alandi

Zoom GSTIN: 27AABCZ4218R1ZP
Zoom PAN: AABCZ4218R

Purchase Order Number:

Customer GSTIN:
Customer PAN:

Road,, Pune, Maharashtra 412105,
pune, Maharashtra 412105 (State Code: 27)
India Whether tax is payable on reverse charge basis - No.

rispmsplacement@gmail.com

Name of Recipient RJSPM's College of Pharmacy, Pune
(Billed to): Gat No. 101-102, Dudulgaon, Moshi-Alandi
Road,, Pune, Maharashtra 412105,
pune, Maharashtra 412105 (State Code: 27)
India

Zoom W-9

Question about your Digital Signature?

rispmsplacement@gmail.com

Charge Details

TAXES, FEES &

CHARGE DESCRIPTION SUBSCRIPTION PERIOD SUBTOTAL SURCHARGES TOTAL
Charge Name: Zoom One Pro
Monthly
Quantity: 1
Unit Price: INR1,300.00 Oct 1, 2022-Oct 31, 2022 INR1,300.00 INR234.00 INR1,534.00
HSN of Goods/Services: HSN
998424
Taxable Value INR1,300.00
Total (Including Taxes, Fees & INR1,534.00
Surcharges)
Invoice Balance INR1,534.00
Taxes, Fees & Surcharge Details
PRIN AL
*ajmata Jijau Shikshan Prasarak Mandal's
COLLEGE OF PHARMACY

Dudulgaon, Pune-412 105.


https://support.zoom.us/hc/en-us/articles/201080605-W-9-Wire-Transfer-Instructions
https://support.zoom.us/hc/en-us/articles/360057516312

Invoice 200Mm

TAX, FEE OR
CHARGE SURCHARGE TAX, FEE OR SURCHARGE
NAME NAME JURISDICTION CHARGE AMOUNT AMOUNT
SGST
Zoom One Pro/Standard
Pro Monthl (Communications) Federal INR1,300.00 INR117.00
Y 9.000%
CGST
Zoom One Pro/Standard
(Communications) Federal INR1,300.00 INR117.00
Pro Monthly 9.000%

Total (Including Taxes, Fees & Surcharges) INR234.00

Need help understanding your invoice?

Standard Pro and Standard Biz are now called Zoom One Pro and Zoom One Business. Please note that your Services will remain the
same and that this name change does not change the price of your current subscription.

This plan includes products with monthly and/or yearly subscription periods. The subscription period for each plan,
and the total charge, INR1,300.00 (plus applicable taxes and regulatory fees), per subscription period for that
product are set out above in the Charge Details section. Unless you cancel, your subscription(s) will auto-renew each
subscription period and each subscription period thereafter, at the price(s) listed above (plus any taxes and regulatory
fees applicable at the time of renewal) and your payment method on file at zoom.us/billing will be charged. You can
cancel auto-renewal anytime, but you must cancel by the last day of your current subscription period to avoid being
charged for the next subscription period. You will not be able to cancel your "base plan" (Zoom Meetings, Zoom
Phone, or Zoom Rooms) without first canceling all other subscriptions in your plan. If you cancel, you will not receive
a refund for the remainder of your then-current subscription period. You can cancel by navigating to zoom.us/billing
and clicking "Cancel Subscription," clicking through the prompts, and then clicking to confirm cancellation. Should
Zoom change its pricing, it will provide you with notice, and you may be charged the new price for subsequent
subscription.

PRINCIPAL
*ajmata Jijau Shikshan Prasarak Mandal's

COLLEGE OF PHARMACY
Dudulgaon, Pune-412 105.


https://support.zoom.us/hc/en-us/articles/360057516312-Understanding-your-invoice-

200Mm

[
ZNVC India Private Limited
X v I Raheja Platinum, No.06A113A,06A127, Sag Baug Road,

Marol, Andheri East, Mumbai, Mumbai City,
Original for Recipient and Duplicate for Supplier Maharashtra, 400059

Invoice Date:  May 16, 2022 Zoom GSTIN: 27AABCZ4218R1ZP

Invoice #: INV148442492 Zoom PAN: AABCZ4218R
Payment Terms: Due Upon Receipt

Due Date: May 16, 2022
Account Number: 3008008069
Currency: INR
Account Information: RJSPM's College of Pharmacy, Pune
Purchase Order Number:
Name of Consignee RJSPM's College of Pharmacy Pune
(Place of supply): Gat No. 101-102, Moshi-Alandi

Road,Dudulgaon, Pune - 412105, Customer GSTIN:
Maharashtra (India), Customer PAN:
::é:E' Maharashtra 412105 (State Code: 27) Whether tax is payable on reverse charge basis - No.

rispmcopexam2020@gmail.com
Zoom W-9
Name of Recipient RJSPM's College of Pharmacy Pune
(Billed to):  Gat No. 101-102, Moshi-Alandi Question about your Digital Signature?
Road,Dudulgaon, Pune - 412105,
Maharashtra (India),
PUNE, Maharashtra 412105 (State Code: 27)
India

rispmcopexam2020@gmail.com

Charge Details

TAXES, FEES &

CHARGE DESCRIPTION SUBSCRIPTION PERIOD SUBTOTAL SURCHARGES TOTAL
Charge Name: Standard Pro Monthly
Quantity: 1
Unit Price: INR1,300.00 )
HSN of Goods/Services: HSN May 16, 2022-Jun 15, 2022 INR1,300.00 INR234.00 INR1,534.00
998424
Taxable Value INR1,300.00
Total (Including Taxes, Fees & INR1,534.00
Surcharges)
Invoice Balance INRO.0O
Taxes, Fees & Surcharge Details
PRINCIPAL
*ajmata Jijau Shikshan Prasarak Mandal's
COLLEGE OF PHARMACY

Dudulgaon, Pune-412 105.



https://support.zoom.us/hc/en-us/articles/201080605-W-9-Wire-Transfer-Instructions
https://support.zoom.us/hc/en-us/articles/360057516312

CHARGE
NAME

Standard Pro Monthly

Standard Pro Monthly

Transactions

TRANSACTION
DATE
Jun 9, 2022

Jun 9, 2022

Jun 9, 2022

TAX, FEE OR
SURCHARGE
NAME

SGST
(Communications)
9.000%
CGST

(Communications)
9.000%

TRANSACTION
NUMBER
I1A-07362100

IIA-07362101

11A-07362102

JURISDICTION

Federal

Federal

CHARGE AMOUNT

INR1,300.00

INR1,300.00

Total (Including Taxes, Fees & Surcharges)

TRANSACTION
TYPE

Invoice Item
Adjustment

Invoice Item
Adjustment

Invoice Item
Adjustment

Invoice Total

DESCRIPTION

Automated Approved Write
Off

Automated Approved Write
Off

Automated Approved Write
Off

Invoice Balance

Need help understanding your invoice?

PRINCIPAL

Invoice ZOom

TAX, FEE OR SURCHARGE
AMOUNT

INR117.00

INR117.00

INR234.00

INR1,534.00

APPLIED

AMOUNT

(INR1,300.00)

(INR117.00)

(INR117.00)

INRO.0O

‘ajmata Jijau Shikshan Prasarak Mandal's
COLLEGE OF PHARMACY

Dudulgaon, Pune-412 105.


https://support.zoom.us/hc/en-us/articles/360057516312-Understanding-your-invoice-

Invoice Zoom

This plan includes products with monthly and/or yearly subscription periods. The subscription period for each plan,
and the total charge, INR1,300.00 (plus applicable taxes and regulatory fees), per subscription period for that
product are set out above in the Charge Details section. Unless you cancel, your subscription(s) will auto-renew each
subscription period and each subscription period thereafter, at the price(s) listed above (plus any taxes and regulatory
fees applicable at the time of renewal) and your payment method on file at zoom.us/billing will be charged. You can
cancel auto-renewal anytime, but you must cancel by the last day of your current subscription period to avoid being
charged for the next subscription period. You will not be able to cancel your "base plan" (Zoom Meetings, Zoom
Phone, or Zoom Rooms) without first canceling all other subscriptions in your plan. If you cancel, you will not receive
a refund for the remainder of your then-current subscription period. You can cancel by navigating to zoom.us/billing
and clicking "Cancel Subscription," clicking through the prompts, and then clicking to confirm cancellation. Should
Zoom change its pricing, it will provide you with notice, and you may be charged the new price for subsequent
subscription.

PRINCIPAL
*ajmata Jijau Shikshan Prasarak Mandal's
COLLEGE OF PHARMACY
Dudulgaon, Pune-412 108.






